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GET YOUR iPHONE READY

THE PUBLIC RELEASE of i0S 17 (as well
as iPadOS 17, macOS Sonoma, and
watchOS 10) is due imminently, and
your iPhone will soon be ready to begin
the process of updating. If you’ve
already been experimenting with the
public beta then what I’m saying might
not be news to you, but let’s assume
you’re playing it safe. While the latest
version of i0S isn’t exactly a huge
overhaul, there are some key upgrades
which make your iPhone noticeably
more usable, and enhance the overall
experience. One of these is something
that you probably use on a daily basis
— I know I certainly do — and that’s
AirDrop. Whereas at present the process of transferring
something from one iPhone to another is a slightly clunky affair,
i0S 17 promises to make this a much faster, more natural process
by allowing you to simply tap another iPhone to automatically
begin the transfer process.

Another minor, but useful new feature in iOS 17 is Contact
Posters, which allows you to create a custom calling design —
now other iPhone owners will be able to see your customized
Contact Poster, and know instantly it’s you calling. It’s the kind
of feature you wonder why it took so long to introduce, as it
makes a big difference to the calling experience. Although one
downside is that maybe now it’ll be easier to ignore someone who
isn’t in your good books...

Also long overdue is Offline Maps in the Maps app. Like me,
you may have occasionally switched over to Google Maps to use
the offline maps functionality just for those journeys where you
can’t guarantee good reception, but I’m thankful I can finally put
Google’s alternative to rest, as I much prefer Apple’s version.

And while I fully appreciate that all-new features in an
operating system update are what grab the headlines, sometimes
Apple does better to spend time improving the existing ones.

What do you think about the i0S 17 update? Has Apple
neglected anything? What would you improve upon? Let me know
atllefters@maclife.com./m

W1

NICK ODANTZIS, Editor

Twitter: @maclife

EMAIL:[[etters@maclife.com
SHARE YOUR THOUGHTS FACEBOOK:[facebook.com/maclitel
TWITTER:[fwitter.com/maclitel

Editor's opinion

© THE TEAM

Andrew Cottle

Art Editor

Can i0S 17's health additions,
such as the Screen Distance
and Time In Daylight features,
break Andrew’s addiction to
fantasy football apps?

Rachel Terzian

Production Editor

It's the little things that make
Rachel excited for i0OS 17, such
as multiple timers, adding
links to Notes, and creating
stickers from Live Photos.

Nick Peers
Contributor

Nick shows you how to go
about cleaning your Mac's
hard drive if it's running out of
space, and thankfully it won't
cost you a penny [p&1)!
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IPhone rising as phone market dips

Consumers choose premium models as demand for cheap phones slumps

BY ALEX SUMMERSBY

GLOBAL SMARTPHONE SHIPMENTS are
forecast to hit their lowest level since
2013, but the iPhone range are
bucking the trend. By shipments, the
four top models are iPhones and, as
sales of high—volume/low—-price
models slump, Apple is now on track
to become the top brand by unit sales
for the first time. It has long been #1
by revenue.

IDC forecasts that worldwide
smartphone shipments in 2023 will
decline 4.7% year over year to 1.15bn
units, the lowest total in a decade.
Counterpoint Research projects
the same total but reckons
this to be a 6% decline.
(Both are analyzing
shipments from
manufacturers to
retailers rather than
sales, but there’s an
obvious correlation, and
Apple and other
manufacturers do not
release unit sales
figures.)

GOING PREMIUM
IDC expects Android
shipments to decline
6.0% but i0S shipments
to grow 1.1%. “During a
time when the entire
market is struggling, it
speaks volumes to once
again see Apple going
the opposite direction,”
said Ryan Reith, a group
vice president at IDC.
The decline is being
attributed to a weaker

4| ocT2023

| economic outlook, particularly in

China, which has adversely affected
consumer demand worldwide. IDC
expects a recovery to kick in next year,
forecasting 4.5% growth over 2024,
but right now consumers are reluctant
to buy. They’re hanging on to their
phones for longer — and when they
do buy, the analyst reports, they’re
choosing premium models.

In line with this, research firm
Omdia said the top—of-the-line
iPhone 14 Pro Max shipped 26.5m
units — more than any other model
from any manufacturer — in the first
half of 2023. By comparison,
its predecessor,

N iPhone 13 Pro
N Max,
\ shipped

Ly

| 23.0m units in the first half of the

previous year, while the top model in
1H 2022 was iPhone 13 with 33.7m
units shipped.

HIGHER DEMANDS

Apple took the four top spots in
Omdia’s 1H 2023 list, with iPhone 14
Pro second (21m shipped), followed
by iPhone 14 (16.5m), then iPhone 13
(15.5m). Five Samsung Galaxy models
come next, with iPhone 11 rounding
out the top 10. In total, the five Apple
models in the top 10 shipped 86.4
million units and the five Samsung
models 46.9 million. By comparison,
the four Apple models in the 1H 2022
top 10 totalled 83.2 million.

Chinese brand Xiaomi had two
models in the top 10 in 1H 2022 but
did not make the chart this year.

Omdia noted that shipments of
== Chinese smartphones saw
™\, double-digit declines from
\ 2022 due to a slump in
the mid- to low-end
smartphone market.

Chinese customers are
increasingly preferring
premium models and
with lackluster demand
in NA, Europe and Japan,
China has surpassed the
USA as the largest
market for iPhones for
the first time. In the
second quarter of 2023,
according to
Techlnsights, China
accounted for 24% of
global iPhone shipments
and the US 21%.




iIPhone
in brief
A bite of the Apple

> PRODUCTION MOVING TO INDIA
Even as iPhone sales in the country
grow, production is shifting away
from China. Apple’'s main contractor
Foxconn is reportedly ramping up
iPhone 15 production in India, as
Apple gradually reduces its
dependence on China. It will be a
long haul, though: at the end of
March, Bloomberg reports, just 7% of
iPhones were assembled in India.

>DON'T SLEEP ON YOUR iPHONE
Don’t sleep on a charging iPhone,
Apple warns in a new safety advisory
(https://apple.co/3aVGOFN). Your
charger and iPhone warm up while
charging, and “sustained contact
with warm surfaces for long periods
may cause discomfort or injury,”
Apple advises. So “don’t sleep on a
device, power adapter, or wireless
charger, or place them under a
blanket, pillow, or your body, when
connected to a power source. Keep
your iPhone, power adapter, and
wireless charger in a well-ventilated
area when in use or charging.”

>MOST iPHONE SALES IN-STORE
At the height of the pandemic, in
2020, 50% of US iPhone sales were
online, but in the second quarter of
2023, according to a report from
Consumer Intelligence Research
Partners (CIRP), the figure is back
down to 35%. Most US buyers prefer
to buy in a physical store — and not
only that, they also tend to buy from
their mobile carrier instead of direct
from Apple. CIRP says 52% of total
US iPhone sales in Q2 2023 were
from a carrier’s physical store, and
27% from a carrier online. In this
period, 11% of US iPhone sales were
from a physical Apple Store and 6%
from Apple online.

Image rights: Samsung.

The latest news from the world of Apple

> Samsung 5K display

A new rival to Apple’s Studio Display

HANKERING AFTER AN Apple Studio
Display? Samsung’s 27-inch ViewFinity
S9 is now available for the same price
($1,599) but features a tilt- and height-
adjustable stand, which is $400 extra
on the Studio Display. The screen can
even rotate 90 degrees, for reading
documents with less scrolling.
The ViewFinity S9's specs
are competitive: 5K
resolution (5120 x 2,880),
218ppi, 600 nits typical
brightness, a matte display
to minimize reflections and
glare, and Thunderbolt 4 and
Mini DisplayPort inputs in
addition to three USB-C
ports. It comes with a built-
in, tiltable 4K camera with
Auto Framing that (like
Apple’'s Center Stage) keeps
you in-shot even if you
move around, and the

screen can be color-calibrated simply
using the SmartThings app on an iOS or
Android device. It has built-in speakers
with Adaptive Sound+, and even
embedded Smart TV apps for when
work time is over, with support

for popular streaming apps and the
Samsung Gaming Hub.

> Apple backs California
Right to Repair bill

APPLE HAS SURPRISINGLY declared
support for California’s Right to Repair
bill, having previously always opposed
laws forcing products to be made
repairable by end-users.

The key factor appears to be that
the bill does not require manufacturers
to allow repairers to disable or bypass
security features, which Apple said
would “threaten consumer safety and
data security.”

The proposed law, Apple's
statement also notes, focuses on
requiring manufacturers to make
documentation, tools, and parts
available to “authorized repair
channels, as opposed to a broader
undefined scope of repairs which may
compromise consumer physical safety,

repair reliability, and device integrity.”
In addition, it requires that “repair
providers disclose the use of non-
genuine or used parts.”

Apple has gradually softened its
opposition to the “right to repair” lobby.
In 2019 it made replacement parts
available to independent repair shops,
and in 2021 it launched its Self Service
Repair program, allowing tech-savvy
customers in the US to repair their own
iPhones using genuine parts. The
program has since expanded to other
devices and countries.

Apple's statement makes clear that
it will continue to support the bill as
long as consumers’ desire to be able to
repair devices is balanced with “device
integrity, usability, and physical safety.”
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Apple's MLS
Season Pass

Fan-focused soccer—atlastl!

Why Major League Soccer is a major deal for Apple TV+

MARC CHACKSFIELD

|— —l ajor League Soccer is
M going through one hell of a

glow—up right now. Apple
|_ has a ten-year deal on the
rights to MLS, thanks to a rather
surreptitious turn of events, where
the owners of the MLS found
themselves owning the entire rights
for every single team and every single
game, both locally and globally. Given
the knotty rights for other leagues
(Premier League included, which sees
its broadcasts split between Sky
Sports, Amazon and TNT in the UK),
this was an opportunity for a
broadcaster to come in and “own” the

entirety of MLS’ coverage globally.
Which is a pretty big deal!

STREAM THE ACTION

In a few short months from acquiring
the rights, Apple created the MLS
Season Pass, a subscription service
available through the Apple TV+ app,
and available in more than 100
countries and regions.

The MLS Season Pass features every
live MLS regular-season match, the
Audi MLS Cup Playoffs, and Leagues
Cup1 all in one place. Plus, the game
that marks the midway point of the
season: the MLS All-Star Game. A lot

Apple CEO Tim Cook and Apple VP for Services, Eddy Cue with some of the stars of MLS Season Pass.
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of the content is free, including the
MLS 360, a near five—hour live show
that captures the key moments from
every match.

“It’s tough, I won’t lie to you, five
hours is a long time,” says MLS 360
host Bradley Wright—-Phillips. “What
helps is that throughout the show you
could have Taylor [Twellman, MLS
commentator] jumping in, or Nigel
Reo-Coker [former MLS player] could
be there and that helps a lot.

“Preparation-wise I keep notes on
players and teams. I rely a lot on my
personality, then a few notes here
and there as there may be some
teams in the West Coast you might
not get to see, so you are looking for
who are their dangerous players and
what they need to do to win that
week. The rest, [ just go for it.”

The MLS 360 show is the pinnacle
of what Apple is trying to do — offer
blanket coverage to make sure all
teams are treated the same. It’s a
monumental undertaking, one that
was hammered home when we visited
an outside broadcasting (OB) truck on
match day, one of a handful that B
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© Cruz Azul
Miami

History in the making: Messi makes his'di

against a Liga MX powerholise.

Cruz Azul vs. Miami

Soccer superstar Lionel Messi is the latest big-
name signing to MLS Season Pass on Apple TV+.

were there to handle the hundreds of
live feeds and turn them into HD live
streams, with just a few seconds delay
from what’s going on in real time to
what you see on the screen.

When it came to broadcasting the
matches, Apple worked with the MLS
to make sure there are consistent
match times and no blackouts —

a first in live sports broadcasting.

“We design our products by
thinking, ‘how do we make the best
product?’ And ultimately, it’s always
worked for us. So that’s kind of the
way we approach this,” says Apple’s
senior VP for services, Eddy Cue.

“Sports is the most awesome
unscripted drama. You just don’t
know what’s going to happen. And so
I think it has tremendous value as we
go forward. This thing can be huge
and it should be huge. And we’ve got
to execute, they’ve got to execute,
and a lot of things have to happen,
but it’s not unrealistic. It is a huge
opportunity.”

FAN SERVICE

The person in charge from an MLS
perspective is Don Garber,
commissioner of the MLS.“We

8 | OCT 2023

Orlando vs. Houston

couldn’t be more excited about
partnering with the largest, most
innovative company in the world,”
says Garber.

“It’s year one of a ten—year deal but
really we’ve hit it by storm. The games
are produced to a very high quality.
Every team has its own room on MLS
Season Pass, in which they can feed an
endless amount of content. So think
about the idea that every club has
their own program to do whatever it is
that they think will entertain, inspire
and provide value to their fans.”

Dallas vs. Charlotte

“In 2022, there were 65 different
start times in the MLS. What Apple
did was come with a blank piece of
paper and said, ‘what can we do?’
Everything they have done has been
about the fan experience — and for
the MLS fan that had been second
rate. All of a sudden the fan is being
treated with the right respect,” says
MLS commentator and former player
Taylor Twellman.

“This is a ten—year partnership, and
we’ve already seen a huge amount.
The MLS Season Pass happened within
the first year, so just think what the
tenth year will be like. We all know in
the media world that three years is a
long time, five years is a long time,
ten is insane.”

Major League Soccer matches will be shown in over 100 countries and regions.

Image rights: Apple Inc.



“THIS THING CAN
BE HUGE AND IT
SHOULD BE HUGE”"
— APPLE’'S SENIOR
VP OF SERVICES,
EDDY CUE

Twellman continues: “The
infrastructure is pretty much there
now. For the ‘94 World Cup there was
nothing. Now every country that
comes to the US, Mexico and Canada,
they’re gonna see the infrastructure
there. That’s all of a sudden going to
amplify the impact on the culture of
the game.”

While the World Cup will shine a
spotlight on US soccer on a national
level, it’s already well within the glare
of the world’s media thanks to the
signing of Lionel Messi for Inter
Miami CF, a club co-owned by David
Beckham, who himself turned the
world on to MLS back in 2007.

STAR POWER

It’s hard to miss Apple’s pink GOAT
billboards celebrating the news of the
best—ever soccer player choosing its
league as his new home. At his
unveiling event, Lionel Messi couldn’t
keep the grin off his face.

Wayne Rooney played for DC
United, before having a stint as
manager of Derby County. He’s back
in DC managing the team he once
played for, and managed the MLS
All-Stars for the All-Star Game
against Arsenal this year.

“The MLS is developing at a rapid
pace. Getting Lionel Messi into the

e
L o —
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Hundreds of live feeds are turned into HD streams
of each match, with only a few seconds of delay.

MLS Season pricing

>MLS Season Pass is available for $14.99/
month or $99/season.

> Existing Apple TV+ subscribers can get
access for $12.99/month or $79/season.

MLS is huge,” said Rooney in the
game’s press conference. “He’s a
player I have always loved playing
against and watching. It’s going to be
great for fans in the States to get to
watch him up close.

“Obviously the Apple deal for the
league is huge and getting Messi could
be a real game changer. We saw it with
Cristiano Ronaldo in Saudi Arabia, the
impact he has had with a lot more
players going out there to play.

“I think it was important for the
league to get Messi in to show that the

The on-pitch action is captured in real time with live feeds sent to outside broadcasting trucks.

Image rights: Apple Inc

The latest news from the world of Apple

Bay

MLS can compete against other
countries for players.”

Arsenal manager Mikel Arteta’s
allegiance is with the Premier League,
but he also noted the importance of
Messi joining the MLS. “The way the
league has developed over the last 20
years is phenomenal. It is very
different now to what it was, thanks
to it gaining top talent and now the
best—ever soccer player. It’s a very
clever move by the MLS and it really
puts a spotlight on the league.”

Past matches include the likes of
Manchester United and AC Milan and
a Skills Challenge was introduced in
2018, which is more akin to what you
see in the NBA league than on the
soccer pitch.

There was a real buzz about the
events this time, with the All-Stars
training within view of Capitol Hill, on
The Mall, and even heading to the
White House to show off their tricks
on the White House lawn.

The MLS All-Star game against
Arsenal was played to a sell-out crowd
of 20,621. While many in the audience
didn’t get the win they wanted, with
Arsenal managing to put five goals
past the All-Star Team, spirits were
not dampened and the applause for
key “home” players such as Christian
Benteke was rapturous.

Having the game played in the same
week that Messi made his debut for
Inter Miami CF, where he scored the
winner from a free kick, has given
Major League Soccer the boost that it
deserves right now. Republished from

[theshiftiews.coms
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> THE SHIFT

MATT BOLTON says that in the current era
of tech madness, it's very welcome for Apple
to be a bit boring sometimes

HEN I SIT down at my fine
mahogany desk and dip
the quill to begin writing
these columns — at my
leisure, safe in the knowledge that
the magazine’s errand boy must
wait in the rain until ’m good and
finished — I’'m obviously looking
at the biggest tech stories around
as a starting point for ideas, to see
whether there’s anything that’ll
affect us Apple users. And I’m
looking at leaks and rumors about
future Apple products to see if I
have something to say about
Apple’s likely direction of travel,
and what that tells us.
On a day like today, when the
stories are all about what an

| FIND IT UNLIKELY TIM
COOK WILL FIGHT ANY

OTHER MAJOR TECH
LUMINARIES IN A CAGE

What's happening?!

While X careers about like a drunk uncle at a wedding, Apple

takes a sip of Kool-Aid and calmly carries on.

incremental change the Apple
Watch 9 and iPhone 15 will be, and
how Apple won’t launch a folding
phone for three years if it ever
does, I’'m not exactly filled with
excitement. My instinctual
response to this news is that I
absolutely refuse to write a(nother)
column about how Apple, and the
tech world, isn’t interesting
anymore because all the “new”
tech is maturing. I have ploughed
this furrow well in the past; we’re
all used to this new normal.

But then I flick past all the
stories about how X (née Twitter)
had to take down the sign on top of
its building (put up due to the fact
the old sign couldn’t be removed

because the company didn’t
have the permits) because it
was brighter than the sun, or
the latest update on the Elon
Musk versus Mark Zuckerberg
cage match, or about how the
new cryptocurrency from the
creator of ChatGPT (ooh, that’s
bingo!)... and I think “Good old
boring Tim Cook. And good old
boring Apple. Long may they stay
this way.”

The tech world is coming off the
rails. Perhaps it’s due to the fact
that large parts of it are funded by
a venture capital system that
demands giant growth no matter
what’s happening in the real
world. Maybe it’s due to all the
companies that are run by people
who’ve never lived a normal day
since college. Every day is
delivering some fresh new source
of “What!? Why!?”

The knock on Tim Cook used to be that he isn't
Steve. Now, the praise is that he isn't Elon.

I find it pretty unlikely that Tim
Cook will attempt to fight any
major tech luminaries, in a cage or
any other venue. I don’t think the
company will start ruining its own
products so badly that we start
begging Microsoft to make a clone
of i0S we can jump to. I don’t think
we’ll ever have to talk about how
sometimes your iPhone creates
hallucinations you have to ignore
when you ask it for information.

I am of the opinion that we have
to be realistic about what kind of
leaps we can expect from
affordable consumer tech products
in the next few years — not from
stuff at Vision Pro prices, where
things can still get spicy, but at
iPhone or AirPods prices. Nice
updates come, but they don’t come
all at once to change the game —
we’ve reached a plateau. And when
I’m in the middle of it, watching all
these companies swerve right over
the edge of the cliff, the plateau
seems very nice thank you.

>>> Matt is Managing Editor at Future's flagship technology website TechRadar and has been charting changes at Apple since
his student days. He's skeptical of tech industry hyperbole, but still gets warm and fuzzy on hearing “one more thing.”
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Like many other readers, I miss the
print version. It’s too easy to forget a
new issue is out amongst all the other
digital icons on my iPad. But I know
there’s no going back on that one.
Reading onscreen does make it easier
to skip over things I’m not interested
in; all the spatial computing stuff
from a previous issue, for instance,
which is not relevant to me and likely
won’t be any time soon.

However, I was disappointed to see
in the August issue (#209) a malware
scare article published that advised
readers to “run antivirus software”
without any recommendations of
such. There wasn’t a category for it in
“Best of the best”, either.

Also, I’d think that with digital
publishing, you could have pulled the
Apollo Reddit app recommendation,
given Reddit’s ridiculous pricing
scheme killed it.

Even with these quibbles, I’m glad
you’re still out there, as you’re the
only publication I trust to give me the
latest Mac and iOS news.

JOHANNA DRAPER CARLSON

Johanna — your feedback is greatly
appreciated. We’re glad that you’re

liking the
digital
version of the
magazine,
it’s surprising
how you
quickly get
used to
reading in this way, and

there are lots of features

that make the experience better (in our
opinion, anyway).

As to the malware article, it certainly
wasn’t intended to scare anyone, but
more of a reminder that Macs aren’t
impervious to malware. We have
covered antivirus apps in the past, and
we even had a group test of the best
antivirus apps in issue 192. Admittedly,
the recommendation never made it
into our Best of the best section, for
some strange reason, so we’ve made
sure to add it to this issue.

With the Apollo app tutorial (§32),
we’re in absolute agreement that the
coverage should have been pulled. The
Apollo app was shut down after the
recent API price hike by Reddit,
and somehow in the madness of
the summer months, we neglected
to pull the coverage.

Too pricey for most?
Vision Pro is a helmet, a darn
expensive topless helmet, that
| could hardly imagine using on
my bike, in the car, with my
friends or family around the
coffee table, in a school
classroom, at my work desk...
But | could probably use it to
watch 3D movies, manage a
photo gallery, Facetime in the
privacy of my living room,
attend a sports event or a
musical concert. Until the
helmet becomes a pocketable

SHARE WITH US!

$1,000, | don't see this type of
gadget as “the one ring” for the
masses. How do you (the
editors) see it?

IGOR SAJN

As a concept, we on Mac|Life
love Vision Pro, but how it
actually stacks up in reality
we will only know when we
get a chance to play with it
next year. The average
person probably won't be
buying one until at least
2025 and beyond. We do

EMAIL:[letters@maclife.com|

FACEBOOK:facebook.com/maclitd TWITTER:[Ewitter.com/maclitd

worry that the time it takes
for the device to reach the
masses might mean that
the current buzz
surrounding it might have
subsided somewhat.

Magazine on Mac
Good job to everybody on the
magazine. | love that it's in
digital — no more stocking the
old magazines. The only thing |
would like to say is that on my
iPad | can read it double
spread, but on my Mac display

I can only see a single

page. it would be great
on the large monitor I'm
using. Hoping you'll be

able to make it so.

PERRY PIZARRO

Perry — that’s a brilliant
point you make. The digital
has many benefits that can
make it far more practical
than the print version,
having instant access to
your issues being one of the
most useful of these.

As to the single page
issue, that's a limitation
of the Mac app being
essentially an iOS port. If
you read the mag using
Pocketmags (which works
on Mac) then you can read
it as a DPS, although
unfortunately that does
mean subscribing again as
it's a separate platform.

How to print?

| struggle to read the
articles on the screen, so |
would like to print an article.
How do | do this?

MIKE KENNEDY

Printing articles is always
useful as a backup, but sadly
there's no option to print
within the Mac|Life app
(assuming that's how you're
reading the magazine), so
the only way to do it is to
take a screenshot, openitin
the Photos app, and print
from there (using the

Share option).

Mac|Lifes®
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SUPERGUIDE

Find out what's coming with iPhone’s next

operating system and what it can do for you

WRITTEN BY IAN OSBORNE

VERY YEAR APPLE
unveils a new
generation of operating

systems at the June Worldwide
Developers Conference. It then
releases them as developer and
public betas a little while later,
and as a finished product by the
fall. The public beta of i0S 17 was
released on July 12, and the
developer beta was made
available for free too.

iOS 17 boasts arange of new
features for any iPhone that can
run them. For instance, there are
personalized Contact Posters to
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design and use, and Live
Voicemails where incoming
messages are transcribed and
the text shown in real time, so
you can decide whether or not to
take the call. Or, if you ring
someone using FaceTime and
they don’t pick up, ini0OS 17 you
can now leave a voice or video
message for them.

The Messages app gets some
upgrades too, such as a more
comprehensive search feature,
inline replies and other cool
functions. For safety, Check In
can be used to send a friend or

family member a message when
you've reached your destination.
Also look out for new Stickers,
sharing contacts via AirDrop, and
a new StandBy feature.

Whether you download the
public beta or wait until the new
operating system'’s final release,
there's plenty to seeand do in
iOS 17. Over the next few pages
we show you some of the latest
features and how to use them.

So what are you waiting for?
Let's take an in-depth look at the
iPhone’s latest iOS 17 operating
system, right now.®m
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LEAR COMMUNICATION IS what
G the iPhone is all about, and Apple

has paid a great deal of attention
to its capabilities in i0S 17. For the Phone app,
there are Contact Posters. You create a
Contact Poster by selecting a photograph or
memoji to represent yourself and choose
whether you want it to be cut out. You can
then choose a font and color for your name

Check In

This great new personal safety
feature sends a message to friends
or family when you've arrived at
your destination. Check In
automatically detects when you've
arrived, and can also detect if
you've been delayed and notifies
you to end the Check In or add more
time. If you don't respond, an alert
is sent, showing your location and
the route by which you arrived
there. All information is encrypted
and completely private.

Phone, Messages
and Stickers

What's new for these key communication apps?

and, if applicable, a color for the
background. When completed, the
Contact Poster will appear on
other people’'s phones when you
callthem. It's also used for your
contact card as a consistent
visual identity across iOS.
Third-party developers can
incorporate them into their calling
apps too.

VOICE TO TEXT
The Phone app’s voicemail
function has also had a boost.
Now, when an incoming call goes
to voicemail, the caller's message
is transcribed and the textis
shown on screen. This feature is
completely private, and the
transcription takes place on the
device, with no information sent
to Apple's servers for processing.
This is useful if, for example,
you get a call from an unknown
number. You can see whoitis
before deciding whether to take the call.
Also, if a friend or family member calls at an

HOW TO Personalize your calls with a Contact Poster

Voicemail

what all that noise
coming from the
basement is.

It's a family of raccoons!
A mom and babies.

They're super friendly
and so cute, but they
kinda stink. After | feed

AW

Message Accept

When an incoming call goes to voicemail in i0S 17, it's
transcribed and shown on the screen in real time.

~ Contact Photo & Poster
=" Contacts Only

mobile

/I First steps

Open the Phone app and tap the
Contacts icon at the bottom of the screen.
Next, tap My Card, followed by the new
Contact Photo & Poster option below your
main contact details, then click Continue on
the next screen.
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Dectine Accegt

CHOOSE YOUR POSTER

© @ @ 10
Camera Photos Memaoiji Monogram
Your Contact Poster

This is your Contact Poster screen. At
the top you'll see how your finished poster
will look with options below to edit your
name, take a photo, add a photo from your
Photos library, use a memoji, or simply use
a Monogram (your initials).

Add a photo

If you want to take a new photo for
your Contact Poster, tap the Camera
button and do so. To use a picture from
your Photos album, tap Photos and accept
one of the suggestions or navigate to the
one you want.

Image rights: Apple Inc.
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HOW TO Use iOS 17's new Sticker features

Add Sticker Select All Share...

Copy

/I Lift a subject

First, to cut a subject out of its
background, tap and hold it until it jumps
off the photo, then lift your finger. A pop-
up menu appears. Choose the new Add
Sticker option to make it available to use
as a sticker.

awkward time, you can decide if it's
important enough to speak with them or
phone back later.

The Messages app is one of the most
popular tools on the iPhone, and it gets a few
new features in i0OS 17. If you want to reply to
a specific message in a chat, you can do so
by swiping the message to the right and
tapping the Reply icon. This is especially
useful in group chats, where things can
often get confusing.

Another feature for group chats is the
icon at the right-hand side of the screen that
takes you straight to the last message you

Stickers X
— .
b
@ ® Add Effect Delete . °

Live Photos

Use a Live Photo and the sticker is
animated, just like the photograph. After
tapping Add Sticker, you can add effects
such as giving it an outline, using a
comic book filter, making it puffy or
shiny, and more.

read in a conversation. Ideal if you haven't
read your messages for a while and the chat
has moved on.

Other convenient functions include new
Search Filters, which make it easier to find
something in the Messages app. After doing
a search, you can then add filters to narrow
down the results.

MORE CONVENIENCE

As mentioned earlier, incoming voicemails
can now be transcribed, but that's not the
only thing that's being transformed into text.
If someone sends you a voice message in

3 Using Stickers

Drag a sticker — or a memoji — into
place in an app and you can rotate it, and/
or pinch and spread to resize it before
dropping it into place, adding extra flair to
your messages. Stickers are far easier to
use in i0S 17, and more versatile too.

the Messages app. it can also be transcribed
s0 you can read it instead of listening to it.

There's also another handy way to share
your location with friends, and you can see
where they are directly in the Messages app.

Fans of Stickers should know that the
drawer has moved from the top of the
keyboard to a new menu. All your stickers are
found in one place, and all emoji can be used
as stickers and can be rotated and resized
when you use them. You can take a subject
from a photo and use it as a sticker, and this
can also be done with Live Photos, making
animated stickers.

4 Position your photo

Choose a picture, then pinch, spread
and drag with two fingers to resize and
reposition it. Tap the Photos icon (bottom
left) to choose a different photo, and the “."
icon (bottom right) to turn the depth effect
on and off.

U Background Colour % ‘

‘N N JOX X
000000

Customize your photo

Swipe the screen left and right to
switch between various photo effects. If
you choose one that features a cut-out
picture on a colored background, tap the
colored circle icon to the left of the “.." icon
to select a color.

W O

Font & Colour X

Aa Aa Aa

_—

é Change the type

Enter your name at the top of the
screen and select a typeface. You can then
use the slider to make the letters thicker or
thinner. A second slider at the bottom of
the screen enables you to change the color
of the text.
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FaceTime, StandBy
and Widgets

New features that will transform your iPhone

HERE'S ONE PARTICULAR to or watch your message at their own
B feature that's beenrequested fora | convenience. It's a great feature,

while, and now it's finally arriving. If | especially for those who prefer free
you make a FaceTime call — audio or video
— and the person on the other end doesn't

pick up, you can leave a voice or video
message. The other person can then listen

The StandBy

internet-based FaceTime calls instead
of standard phone calls.

STAND BY FOR STANDBY

A feature coming to the iPhone, iPad
and Mac with the next operating
system updates is chat reactions.
These can be activated with on-screen

Music Player

If you're playing music on your
iPhone when you connectitto a
charger and activate StandBy, you
get a wave form representing your
tunes. Tap this and you open the

menus or simple gestures. For
example, two thumbs-up gives you a
firework display. Other reactions
include hearts, balloons, laser beams,
rain and more. These can also be used
in third-party video-calling apps as

well as FaceTime.

However, the one new feature that
really looks amazing is StandBy. Simply
turn your iPhone to landscape mode
and connect a charger — a wireless Qi- Max, the StandBy screen is always on, but if
compatible device or Lightning cable — and you own an earlier iPhone running iOS 17,
StandBy will be activated. The screen will be simply wake the display with a tap.
turned on to give you information at a glance When in StandBy mode, the iPhone can
— if you have an iPhone with an always-on display the time using different clock styles.
screen, that is. With an iPhone 14 Pro or Pro Look out for a digital design with bubbly

HOW TO Utilize the StandBY features

Music Player StandBy screen,
offering an album cover, track
information and basic controls.

If you make a FaceTime call and the person doesn't
answer, you can now leave an audio or a video message.

o4 Martin Smim

]

Notifications

When you get sent a notification by

Customize screens
Tap and hold the screen for
customization options. You can change the an app such as Messages, it will appear on

/l Swipe sideways

When you have activated StandBy
mode (by connecting your iPhone to a
charger while it's in landscape mode and
locked), swipe the display sideways to
switch between the clock, photo and
widgets screens.

pictures displayed by the photos screen,

scroll through and customize the various
clock options, and change the widgets on
the widgets screen.

your StandBy screen. If you don't want
these to display while the phone is on
StandBy, then use Focus to keep the
notifications quiet.
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¢ Back Sensitive Content Warning

Sensitive Content Warning

View Safety Resources

APP & SERVICE ACCESS

@ AirDrop

U Messages

E Video Messages

ANALYTICS & IMPROVEMENTS

Improve Sensitive Content Warning

Ahout Improve Sensi

Switch on the Sensitive Content Warning to help
prevent offensive images and messages.

numbers, which you can color-customize, a
more sombre digital clock with a gradient
background, a rectangular analog clock face
that fits the screen beautifully, plus other
options. There's also a world clock that
displays the time in cities you've saved in the
Clock app too.

StandBy can also be used as a digital
photo frame, showing pictures curated from
your Photos app. If you want to change the
Featured, Nature, Pets, Cities and People
categories offered, tap the Plus icon and
choose one of your photo albums instead.

Two thumbs up triggers a FaceTime fireworks display.
You can use these reactions in any video chat app.

FaceTime on Apple TV

The FaceTime app is coming to Apple
TV 4K with its own operating system
update, tvOS 17. Harnessing the
power of Continuity Camera, Apple

When your photos are shown, the time,
the location the picture was taken in, and the
current date are also displayed. If you'd
prefer not to have this showing, then tap the
screen to toggle these details on and off.

WIDGETS VIEW

Perhaps the most interesting use of the
StandBy feature is the widgets view. Two
square-shaped widgets sit side by side on
the screen. By default, there's a circular
analog clock on the left and a calendar in the
month view on the right. Tap and hold either
of these widgets to open the widget picker.
You can replace the calendar with a weather
widget, events list, or a reminders roundup.
Tap and hold the clock on the right to change
it to the date, a page from Stocks, ora
different clock face. Alternatively, you can
swipe the widgets up and down to cycle
through them instead of tapping and holding
for the widget picker.

If none of these appeal to you, tap the
plus icon on the widget picker screen and
select a different widget, taken from your
iPhone. Just about every square-shaped
iPhone widget is represented there, so the
choice is yours.

TV's FaceTime app uses your iPhone
as a webcam. Center Stage keeps
everyone perfectly framed on the
screen, too.

The clocks in StandBy look great on your bedside
table, and will dim down in low light. You can
customize the clock to suit your tastes too.

For those who like to charge their iPhone
on their bedside table overnight, the
StandBy feature recognizes when the light is
low and gives the screen a red hue so your
sleep isn't disturbed.
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AirDrop, AirPlay and SharePlay

Introducing new i0S 17 features to help you share, work and play smarter

IRDROP IS BY far the easiest and
most convenient way to share files

such as photos and videos
between Apple devices. Simply open the file
in question, tap the Share menu and select
AirDrop. Nearby Apple devices will be shown,
and all you have to do is tap the one you wish
to send the file to, and it's automatically
transferred using an ad hoc wireless
connection. But with the launch of i0S 17,
AirDrop is about to get even easier — at least
when it comes to transferring content
between two iPhones.

Instead of going through the Share menu
and selecting AirDrop, in i0S 17 all you have
to dois bring your iPhones close together
and the file transfer is carried out
automatically. It's as easy as that. If your
iPhones move away from each other and out
of AirDrop range while the file or files are
being shared, the transfer carries on
regardless via iCloud until it's finished — or at
least it will once iCloud transfers become
available later this year.

The technology used for AirDrop has also
been repurposed for another great new
feature. Currently, exchanging contact
details with another person can be fiddly,
and there are a few ways it can be done. You
can share a contact card from the Contacts
app. hand your phone to the other person so
they can type in their details, or have them
dictate their information as you do the
typing. Butin i0S 17 there's a new, super-
convenient way of sharing your contact
details: NameDrop.

Want to watch films or play music on your travels? Use AirPlay in hotels to connect to your room's screen.

To use NameDrop, simply bring your
phones together, and your personal contact
cards will be shown onscreen. You'll then see
two buttons on the screen: Share and
Receive Only. Tap Share to exchange contact
information, or tap Receive Only and you'll
take the other person’s card without passing
your own.

To use NameDrop, both iPhones need to
be running i0S 17, although you can also
NameDrop between an iPhone and an Apple
Watch running watchOS 10.

AIRPLAY MADE EASIER
Apple promises that in i0S 17 and its other
new operating systems, AirPlay will be “more
seamless than ever”. The iPhone (and iPad)
use on-device intelligence to learn the way
you use AirPlay. For example, if you use it to
send music to your kitchen HomePod while
you cook in the evenings, the iPhone
recognizes this and when it's time to start
cooking, a notification will show up inviting
you to AirPlay to the HomePod.

Another way to get your HomePod to
start an AirPlay session is to ask Siri. Apple's
digital personal assistant can respond to
more instructions, making it easier to enjoy
your tunes this way.

If you want to enjoy home comforts when
you're away, a new service that's launching
soon is AirPlay in hotels. If the screen is
compatible, you'll be able to connect your
Apple mobile device through AirPlay by
scanning a QR code on the TV. You can then
enjoy your media on the television in your
hotel room. Halfway through a season on
Apple TV? Pick up where you left off.
Enjoying a new album you discovered on
Apple Music? Listen to it through the TV.
AirPlay in hotels is coming to selected
venues later this year.

If you own
an Apple Watch
with watch0S 10,
you'll be able to NameDrop
between an iPhone

and your Watch.

Image rights: Apple Inc.
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With CarPlay, everyone in the
car can soon join in and share.

@ Jasmine >

Echolalia
Yves Tumor

SharePlay and CarPlay

Apple Music and CarPlay will also have
an update in the fall, with SharePlay
support enabled in the car.

Apple is making it even easier to share
and control your music while on the
road. When one person’s iPhone is
connected to CarPlay, other passengers

can use their phone to scan a QR code
inviting them to join the CarPlayer’s
session. With this, you can connect and
share your music through CarPlay.
Listeners can control the music from
their own devices, even if they don't
have an Apple Music subscription.

HOW TO Swap numbers with NameDrop

SharePlay with Jasmine
Tap o join

Control the music even without
an Apple Music subscription.

SharePlay is another feature that can
be achieved by bringing phones
together. For example, if you want to
share music on a run or want to watch
the same live stream on Twitch, you can
do so via SharePlay. It works for all
compatible Apple and third-party apps.

Share or Receive Only

Contacts received

/I Bring iPhones together
To initiate a NameDrop and exchange
contact details with a fellow iPhone owner,
all you have to do is bring your phones into
close proximity (with AirDrop enabled on
both phones). Your Contact Posters will
then appear on both your iPhones’ screens.

As well as the Contact Posters, two
buttons will appear at the foot of each
iPhone’s screen; Share and Receive Only.

If you want to send your details to the other
phone, tap Share. If not, tap the Receive
Only button.

The pair of nearby iPhones will then
each send the contact card to the other
device wirelessly, and the owner will see it
appear on the screen. And that's all
you have to do. It really is that easy
with NameDrop.
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Health and Fithess

Look after your eyesight and more with i0OS 17

AKING CARE OF your eyesight is
important when using screens,

especially for children whose eyes
are not yet fully developed. It's been
estimated that around 30 per cent of the
world’s population is short-sighted (myopic),
and this figure is set to rise. According to
eyecare experts, there are two key ways that
children can look after their eyesight and
reduce the risk of short-sightedness, and

both are addressed in the i0S 17 update.

Going outside during daylight hours is
very good for the eyes, and Apple's new
Time In Daylight is great for measuring how
much time you and your children are
spending outdoors. Find this feature in the
Health app — go to the Browse tab in the
bottom-right, look for Mental Wellbeing and
tap it to find the new Time In Daylight

category. The app suggests that for children,

spending 80-120 minutes outside each day
can help lower the risk for myopia.

P
T,

iPhone is Too Close

Keeping your iPhone at arm'’s length can protect your eyesight.

With Screen Distance, you're warned if you hold your device too close to your face for an extended period.

Fitness+ Custom Plans

Go to the Fitness app. tap Fitness+ and
under Custom Plans you can build a
tailor-made workout schedule for
working towards your own goals.

The plan can be set to last between
two and eight weeks with program
times of between 10 and 90 minutes,
on a per-day basis. You can also
choose which activities you want to do

including Pilates, cycling, dance,
rowing, treadmill, meditation and
more. You can even choose your
trainers and the music you listen to
while you work out.

Also look out for a cool Stacks
feature that lets you carry out back-
to-back workouts, one after another, if
you so wish.

This feature works best if you have an
Apple Watch running watchOS 10. The
feature then uses your Watch's ambient light
sensor to identify when you're outdoors, and
automatically updates the Health app. If you
don’'t have an Apple Watch, or you have one
that's too old for watchOS 10, you can
manually add your time spent outside. Just
tap the Add Data link in the top-right corner.

SEE DAYLIGHT
Time In Daylight data is shown as a bar
graph. You can check your records for the
last day, week, month, six months, or year,
and by tapping one of the bars, you can see
more about your time spent outside on a
certain day or hour. Scroll up to add Time In
Daylight to your Health app’s Favorites.
Another way of preserving your or your
children’s eyesight is to make sure you don't
hold your screen too close to your eyes when
you read, causing eye strain. In the Settings
app, tap Screen Time and look for Screen
Distance. Tap this option to turn the Screen
Distance feature on or off. With Screen
Distance on, if you spend too much time
reading with your iPhone or iPad (with Face
ID) too close to your face (a distance of
around a foot is recommended), you will see
a warning screen. Move the device further
away from your face and you will be notified
that you're reading at a safe distance, and
can continue.

Accessibility

Accessibility is getting some new
features with i0S 17. Personal Voice
records you speaking 150 different
phrases and using machine learning, it
turns this into a live speech narrator that
sounds like you. Assistive Access
increases the size of your essential apps
to make them easier to use for those who
have difficulty pressing buttons. Look out
too for features such as Point and Speak,
Live Speech, and more.

Image rights: Apple Inc.
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< Back Time In Daylight Add Data

THIS FEATURE 7 o
WORKS BEST IF YOU
HAVE AN APPLE a.
WATCH RUNNING min
WATCHOS 10; IT 2 Aug 2023
USES YOUR
WATCH'S AMBIENT
LIGHT SENSOR AND
AUTOMATICALLY
UPDATES THE
HEALTH APP

TOTAL

About Time In Daylight

Time in Daylight is an estimate of the
amount of time spent in sunlight. For
children, spending 80-120 minutes
outside each day can help lower the risk
of myopia or short-sightedness. For
adults, spending around 20 minutes
outdoors every day has numerous

phvsical and mental health benefits.

X o
A mo

Sharing Browse

Point and Speak Instructions

xt, hold your hand

Done

Point and Speak is for iPhones
that have a LiDAR scanner.

It's recommended children should spend 80-120 minutes outdoors a day. Track it with Time In Daylight.
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Maps, Safari and Passwords

Embrace new features for better browsing, navigation and security

O UPDATE TO iOS would be
m complete without new features for

Safari, and this one definitely
delivers. The way Private Browsing works
has been overhauled, giving you more
protection when using a private tab.

If you leave a Private Browsing tab open
and your phone locks, then the private tab
also locks. When you unlock your phone
again, you have to unlock your Private
Browsing tab separately with Face ID, Touch
ID or your passcode. This new feature is
useful if you forget you had the private tab
open and hand your phone to someone else;
they can no longer see what you were

Cancel New Profile

NAME AND ICON

University |

Favourites University

Open New Tabs

On Start Page

QIWIEJRJTYJULT O

AISIDIFIGIH]JIK]L

looking at, which is what private browsing is
all about.

A feature that was built for private
browsing but has made its way to regular
browsing tabs is tracking URL removal. If you
open a URL in a Private Browsing tab, Safari
automatically strips out tracking information
added to the URL, and unknown trackers are
blocked. Tracking information is used to
monitor your activity online, reporting on
what sites you visit and what you do there,
building up an online profile that can be
used, for example, to target advertising.
Thus, eliminating trackers is another way
Private Browsing can keep your online

Safari
Profiles

Another new feature ini0S
17's Safariapp is Profiles. An
expansion of tabbed
browsing, Profiles lets you
divide saved websites into
groups such as Personal, Work
or School. Each profile has its
own favorites, cookies,
browsing history, Tab Groups,
Safari extensions and website
data, so your browsing is kept
contained within a Profile.

To set up a browsing profile,
in the Settings app, go to
Safari and tap New Profile.
You can then customize it by
choosing a name, icon and
color. Next, assign already
saved Favorites toitand
choose which website new
tabs openin that profile.

activities just that — private.

i0S 17 introduces Advanced Tracking and
Fingerprinting Protection for browsing.
Fingerprinting is an advanced type of
tracking, which uses your device’s unique
profile to track you online instead of installing
cookies. In some countries this is illegal
without user permission.

Ini0S 17, you can strip tracking
information from URLs without switching to
Private Browsing, if you choose the option to
do so. In the Settings app, tap Safariand at
the bottom of this screen, tap Advanced,
then tap “Advanced Tracking and
Fingerprinting Protection”. On this screen,
you can switch tracking protection off for all
browsing (private and otherwise), have it
switched on for Private Browsing only (the
default option) or have it active for all
browsing in Safari on your iPhone.

Other new privacy features in Safari
include choosing separate default search
engines for regular and private browsing,
hiding your IP address from websites, and
search suggestions in Private Browsing,
based on popular searches.

USE MAPS OFFLINE
A very useful — and somewhat long overdue
— feature is coming to the Maps app. From
shaky beginnings, Maps has evolved into an
excellent means of finding your way around...
as long as you have a decent internet
connection. But now, in i0S 17, you can finally
download a mapped area to your iPhone, and
then use it offline.

A downloaded map offers a similar set of
features to a regular one. You can use it for
turn-by-turn navigation, check an estimated

118 wi

< Advanced Tracking and Fingerprinting...

Off
Private Browsing v
All Browsing

If preventing trackers monitoring your online activity
is important to you, turn it on for all browsing.

Image rights: Apple Inc.
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Cancel New Shared Group Create

GROUP NAME

Shared Passwords

Apple’s three key 2023 operating
systems —i0S 17, iPad0S 17 and
macO0S 14 Sonoma — enable you to
share passwords and passkeys

Family Passwords

feature doesn’t simply share all of
your passwords.

As the group’s originator, you
remain in control of who's in and

GROUP MEMBERS

‘ lan Osborne

Owner

safely and securely. who's out; remember, you can add or

To set up a group to share remove members at any time. 9 millie
passwords with friends and family, Other members can also add or
go to Settings > Passwords and tap remove passwords of their own to 0 ks
“Share Passwords with Family”. You the group. Sharing is through iCloud
can then create a group, by default Keychain, so it's end-to-end +  Add People

based on Family Sharing.

You also have the ability to add and
remove members who are in your
Contacts app and decide which
passwords you will share — the

encrypted and very secure. You can
set up as many shared password
groups as you like, but everyone in
the group has to have an iPhone
running i0S 17.

"Passwords" Pictures

Set up a group, and then share selected passwords
between you.

g O SR D S
Offline Maps X
Download New Map
Suggested Maps ° Article Talk
- Teignbridge @ LISten l,to 3 Manage Extensions
&8 273.6 MB Based on your home Pages In

Safari

GoodLinks

ns for

-earn more

Ini0S 17's Maps app, you can download the map of a m‘?::gkgzp{?gﬂ acted
given area and use it offline on your iPhone. If you find a web page that
interests you but you'd Website Settings

time of arrival, find places of interest in the prefer to listen to it instead on June 5,
locality, and more. This will prove especially of read it, you can now do Turn Off Cantent Blockers slopers
useful when visiting remote locations that s0ini0S 17. Open Safari, or beta.!]
might have a patchy — or even no — cell and navigate to the web Request Desktop Website that may
phone coverage. page you want to have read count;

To download a map, tap your initials or out loud. Tap the “Aa” icon Hide Toolbar ription to
profile picture, tap Offline Maps and then in the Search field at the
follow the on-screen instructions. top or bottom of the Report Translation Issue

Also coming to Maps in the US is
information on park trails, and real-time
charging information for electric
vehicle drivers.

IN iOS 17, YOU CAN
STRIP TRACKING
INFO FROM

URLS WITHOUT
SWITCHING TO
PRIVATE BROWSING

screen, then tap the “Listen
to Page” option. If the
option is grayed, this
feature isn't available on
the web page. If it's
available, then the web
page’s text will be read out
in a very natural-sounding
voice. To stop listening, tap
“Aa" and the “Listen to
Page” option again.

Translate Website...

Listen to Page
Show Reader

100%

@
e
@
B

A

AA 3

# en.m.wikipedia.org
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Everything else

What else is new in Apple’s forthcoming iOS 177

HERE ARE EVEN more fantastic
features coming to i0S17. For

instance, the Health app will now
enable you to log your moods and emaotions,
and when sufficient data has been built up, it
will offer information to help you manage
your wellbeing.

If you use AirTags — Apple’s Bluetooth
trackers used to keep tabs on your
possessions — there's a new feature just for
you. Ini0S 17, an AirTag can be shared with
up to five other people, a feature that also
works with all other Find My network
accessories. This means your designated

Mot Playing

< Pp »

contacts can also track the location of an
item protected with an AirTag using their
own Find My app. They can also ping the
AirTag so that it plays a sound, and when
you'e close to the AirTag, use Precision
Finding to determine its exact location.

To share an AirTag, open it in the Find My
app. and tap Share This AirTag. You can then
add others to share it with.

AIRPODS EXTRAS

AirPods users also get some great new
features. You can mute and unmute calls by
pressing the stem (or Digital Crown with

Ping Your
Apple

Watch

The Apple Watch has been
able to ping your iPhone for
years. And now, ini0S 17,
you can use your iPhone to
ping your Apple Watch
right back.

It's a feature found in the
iPhone Control Center, but
you need to add it manually
before it can be used. Open
the Settings app. tap
Control Center and tap the
“+" to the left of Ping My
Watch. Now, when you open
your iPhone’s Control
Center, you'll see a ping
icon for your Watch. Tap
that and your Watch
plays a tone.

AirPods Max). This works with AirPods Pro,
Max or third—gen AirPods. Meanwhile, new
listening mode Adaptive Audio (second-gen
AirPods Pro only) blends Transparency and
Active Noise Cancellation.

Another feature limited to second-
gen AirPods Pro is Conversation Awareness,
which, when the user starts speaking, lowers
the volume, reduces background noise, and
enhances voices in front of the user. Finally,
if you use your iPhone in Dark Mode, the
connection pop-up you get when pairing
your AirPods is also dark.

SIRI, MUSIC AND MORE
i0S 17,iPad0S 17 and macQS 14 are also
bringing some interesting changes to Siri.

Instead of having to say “Hey Siri" to
activate the Apple assistant, you'll only need
to say “Siri". You can also chain multiple
commands together instead of having to
repeat them one by one.

One Music app feature people have been
asking for is crossfades, and at long last, it
arrives with i0S 17. Activating the Crossfade
option in Settings > Music makes your tunes
fade out, as the next one fades in, so the
music never stops.

If you use the Home app to control smart
home security devices, you'll now be able to
view up to 30 days of activity history across
door locks, garage doors, alarm systems and
contact sensors. Plus, two features in
HomeKit — tap to unlock and PIN codes — are
being made available for Matter-compatible
locks too.

Timers

00:52

1 min

In i0S 17, you can use multiple timers in the Clock
app. Tap the Plus icon (top right) to add one.




i0S 17 superguide

Dictation & Typing

Textinput is set to get even easierin
i0OS 17. The on-screen virtual
keyboard, which appears when you
need to enter text, is now more
intelligent. Autocorrect is also more
accurate, and if an autocorrection
isn't what you want, the word you
typed is offered as a replacement.
An autocorrected word is
underlined, with the word you typed
shown above it. If you want to go
back to your typed word, just tap it.
This way, you can revert a mistaken
autocorrect without having to
retype the word you intended.

llSiri"

Drop the “Hey"; in i0S 17, you'll be able to activate
Apple’s assistant simply by saying “Siri".

Meanwhile, the Photos app uses machine
learning to better recognize people in your
pictures; it can also recognize cats and dogs.

STAY ORGANIZED

The Reminders app now has a Shopping list
that automatically groups items into
categories. Open Reminders, tap Add List,
and under List Type, select Shopping.
Correct items assigned to the wrong
category and the app will learn from its
mistakes over time.

The Health app can send medication
reminders 30 minutes after an alert, in case
you missed the first one. In the app. tap
Browse then Medications and turn Follow-
Up Reminders on and off.

Have you ever wondered why, in the Clock
app. you can only set one timer at a time?
This can be an issue if, for example, you're
cooking. Well, now in iOS 17, you can set
multiple timers. Woo-hoo!

Watch out for more i0S 17 tips, tricks and
secrets over the next few issuesl!

Predictive text already offers
words to help you complete your
sentence with a single tap. And
now ini0S 17, inline completions are
also offered for partial sentences as
well as single words. These appear
in gray where you type. If the inline
completion offered is what you
want, accept it by tapping Space.

Finally, a convenient new
Dictation engine makes the
keyboard's speech-to-text facility
even more accurate. Like
autocorrect, Dictation is powered by
machine learning.

Link
Notes

If you have entries in the
Notes app that are about a
similar or connected
subject, you can link them
ini0S 17.

It's easy to do. Open the
note where you want the
link to appear, then tap and
hold to place the link. In the
pop-up that appears, tap
Add Link. EnteraURL ora
note title in the box and, if
you want, give it a name.
Tap Done when finished,
and a link to another note
will be placed on your
original note.

May the best ping pong player win! 1

P.S. Weather will be hot! Stay hydrated and

plenty played

Inline completions make typing even
faster and easier in i0S 17.

O

Use Note Title as Name
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HOW TO DO ANYTHING ON YOUR MAC, iPHONE & iPAD

_ PART
Improve your home movies

Trim, adjust, enhance, and resize your videos for social media

REQUIRES

Adobe Premiere Elements
2023 ($99.99),

mac0S 11 or later

()

YOU WILL LEARN
How to edit, improve,
and export videos

IT WILL TAKE
15 minutes

THANKS TO OUR ever—present
iPhone we tend to shoot a lot of
video footage of everyday events.
Unedited clips are dull to watch,
but thanks to Premiere Elements 2023’s
machine learning (ML) features we can
quickly cut and trim out the boring bits to
create slick social media sequences
that our friends, family and
followers can enjoy.

Adobe Premiere Elements uses
the Al-assisted Candid Moments
tool to analyze a long clip’s
rambling content and then quickly
cut it into shorter and more
interesting sections that tell a
story more succinctly (while also
removing sections with poor focus
and bad lighting). If a clip doesn’t
quite look its best (due to exposure
issues or color casts for example),

.
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HOW TO Extract using Candid Moments

we can tweak its colors and tones to create
more attractive—looking footage. We can
even use Premiere Elements 2023 to resize
our horizontally shot footage so that it will
fill the frame in our iPhone’s vertically
displayed social media streams.

GEORGE CAIRNS

Make quick and easy adjustments using Premiere Elements’ tools for
reducing noise, fine-tuning color, fixing underexposure and more.

Piase dich ate Eracy Betmen 1o shom
Canchel Mo,

oAt -——

Import unedited clip
Choose File > Add Media from >
Files and Photos. Browse to import

a clip. Drag the clip into the timeline.

In our example, we have just over a
minute of footage featuring a mix

of interesting action and boring bits.

28 | OCT 2023
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Firune chick “Auto Extract’ button 1o shiw
Candid Moments.

Auto extract

To find the best bits, click on the
clip in the timeline. Choose Tools >
Candid Moments. Click Auto Extract.
The tool will examine the clip for faces
to keep. It will also look for focus and
lighting problems to remove.

Export to timeline

Here Candid Moments found six
sections where faces were visible and
the action was interesting. It removed
out-of-focus sections and bits where
people weren't facing the camera. If
you're happy. click “Export to Timeline”.

Image rights: Apple Inc, Adobe.



How to do anything on your Mac, iPhone & iPad

HOW TO Fix image problems

B N T
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Reduce noise

In low light, video clips can suffer
from grain (noise). Click on the FX icon
and drag the Reduce Noise effect onto
the noisy clip. Click the Render button
in the timeline to smooth noise while
preserving key details.

Banish the blues

Our subject has a cold (blue)
color cast. Go to “Temperature and Tint"
and tap the preview thumbnails to warm
up the clip. Click More and fine-tune
the Temperature slider. Green and
magenta tints can also be removed.

Improve exposure
Our subject is underexposed. In
the Fix section of the toolbar, click

the Adjustments icon. Toggle open
Lighting. Click thumbnails to brighten
the shot in increments. Click More to
fine-tune the result using sliders.

HOW TO Prepare for social media

o |
o
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Add to timeline

Wi # i

Reframe

Go social

Some social media sites (such as
Instagram) prefer to display clips in
portrait (vertical) rather than landscape
(horizontal) orientation. Choose File >
New Project. Click the Social button
and choose Instagram Video.

Import a horizontal clip into the
vertical project. Drag it to the timeline.
Choose Keep Existing Settings in the
dialog window. The horizontal clip will
have black bars above and below it
because the project’s shape is vertical.

Click on the Auto Reframe icon
above the timeline. Premiere will use
Al to analyze the position of a person.
It will reposition them throughout the
sequence so that they stay visible
within the vertical frame.

> SHARE TO SOCIAL

Render a reel to upload to Instagram

Once you've used the Auto Reframe tool to make sure that your subject
remains visible in a vertical frame (see the “Prepare for social media”
steps), go to File > Export and Share. Click the Social Media icon and
then click on the Instagram tab. Select the 1,080x1,350 shape. Check
the Output Preview to make sure there are no bars at the frame’s edges.
Use a Standard file size to make a lighter and easier clip to upload. Click
Save and Premiere Elements 2023 will render a portrait-shaped movie
that is suitable to be uploaded to Instagram.

Image rights: Apple Inc, Adobe.
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Use mobile apps on mac0S

Run iPhone and iPad apps and games on your Apple silicon Mac

REQUIRES
An Apple silicon Mac,
mac0S 11 or later

YOU WILL LEARN
How to download and install
i0S and iPad0S apps and
games on to your Mac

IT WILL TAKE
10 minutes

=

GENIUS TIP

Some iPad apps say “Not
verified for mac0S” in the
App Store. They will work,

but they haven't been
tested on macOS by the
developer, so they may be
a bit buggy.

. \ "' Qs
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EVER SINCE THE first Apple
silicon Macs arrived in 2020,
they’ve offered an additional
benefit — the ability to run
iPhone and iPad apps too with no messy
conversion required. That’s because devices
like your iPhone, iPad, and M1 and M2 Macs
effectively run on identical architecture —
the major difference being that while Mac
apps are designed to be used with a mouse
or trackpad and a keyboard, iPhone and iPad
apps use touch—-based taps, swipes, and
other gestures.

[

HOW TO Run mobile apps on Mac

To get around that, macOS has a feature
called Touch Alternatives that “remaps”
iPhone and iPad apps so they can be used
with your Mac’s input devices. This should
work with the overwhelming majority of
iPhone and iPad apps, but there are
exceptions. Developers can, if they wish,
explicitly prevent their iPhone and iPad apps
from running on Apple silicon — often
because they already offer a perfectly good
Mac version. For apps that aren’t available,
try iMazing ($39.99, DTTPS://iMazing.com).
Read on to find out more. ALEX BLAKE

Search the Mac App Store

In the Mac App Store, try searching for an
app. On the results page, click the iPhone & iPad
Apps tab, then click an app. Under the app’s
name you will see “Designed for iPad”, indicating
that it is an iPadOS app.

Geta new app

You can download the app from here.
You don't need to do any additional work,
as macOS-compatible i0S and iPad0S apps
will simply work straight away once they
are downloaded and installed.

Image rights: Apple Inc, Vaccor LLC, Innersloth LLC, DigiDNA SARL.
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Apps in your account

You can also download i0S or iPad0S
apps already tied to your iCloud account. Open
the Mac App Store and click your account in the
bottom left. Under Account, select iPhone & iPad
Apps and pick an app to install.

New controls

The Touch Alternatives menu shows the
controls that let you use gesture-based apps on
Mac. You'll see a diagram of your keyboard and
mouse or trackpad, with touchscreen swipes and
taps mapped to their buttons.

o iMazing
Some iPad apps aren't available in the

Mac App Store, but if they're on your iPhone or
iPad you can install them with a Mac app called
iMazing. Install iMazing, then connect your
unlocked iPhone or iPad to your Mac.

Image rights: Apple Inc, Vaccor LLC, Innersloth LLC, DigiDNA SARL.

How to do anything on your Mac, iPhone & iPad

Touch Alternatives
Apps for touchscreen devices come with
tweaks called Touch Alternatives in order to work
on Macs. In the downloaded iPhone or iPad app.
click the app’'s name in the top left, then select
Settings > Touch Alternatives > On.

Game optimizations

Games have their own touch alternatives
that are better optimized for gaming. Click [App
name] > Settings > Game Control to use your
keyboard and mouse in place of a controller,
tweak pointer sensitivity, and more.

Export .IPA

In iMazing, click Manage Apps > Library
and click the Download button next to your
chosen app. Now Ctrl-click the app and select
Export .IPA. Save the file, then open it. This
will install and run the app on macOS.

JARGON BUSTER

Touch Alternatives

are controls that mimic
touch gestures on your Mac,
letting you use the arrow
keys to swipe left and right,
for example.

=

GENIUS TIP

Not all iPhone or iPad apps
downloaded via iMazing will
work on your Mac. You
might get an error message,
in which case you'll need

a replacement app.

0CT 2023 | 31



, Green.pxd

QUICK LOOK Work with the Remove Color feature

Adjustments
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Fade

Elack & White

Channe! Mixer
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LAYERS

Once you've created a transparent
background on the top layer you
can add a new background

on the layer below.

REMOVE COLOR

The new Remove Color tool lives in
the Color Adjustments panel. Toggle
it on to get started.

SAMPLE FINE-TUNE
After picking the eyedropper use the These sliders fine-tune the range of
Loupe tool to magnify and sample colors that are removed, which is
the color that you want to remove. effective for removing unevenly

lit backgrounds.

Selective color editing

Indulge in creative compositing using Pixelmator Pro 3.3's handy tool

REQUIRES
Pixelmator Pro 3.3 ($49.99),
macO0S 11 or later

YOU WILL LEARN
How to remove a
specific color and add
a new background

IT WILL TAKE
10 minutes

32 | OCT 2023

THE MACOS VERSION of Apple’s
Photos app has a Selective
Color panel that enables you
to target a specific color in
a picture and change its hue, saturation
and brightness. This powerful tool is a
springboard to a range of creative looks
such as turning a blue sky into a cinematic
cyan. You can also selectively darken the
blue sky to make the clouds pop out in
contrast. Pixelmator Pro has a very similar
selective color panel, but thanks to the
latest upgrade that app now boasts an
additional tool that Photos doesn’t have:
Remove Color.

This useful tool enables you to target a
specific color (such as a green background)
and turn it completely transparent. You can

then place another image on a layer below
to give your isolated subject a new
background. Remove Color works with stills
and videos, so we’ll put it through its paces
with a green screen video clip (though the
techniques are identical for removing color
in still images).

BLUE SCREEN ON A BUDGET

We shot our subject against a colored
backdrop in a dedicated green screen studio,
but you could purchase a large green (or
blue) card and use it as colored background
for your subject. This green/blue screen
compositing technique could be handy for
YouTubers who want to add a more exciting
backdrop to their “talking heads” footage.
GEORGE CAIRNS

Image rights: Apple Inc, Pixelmator Team



HOW TO Remove colors

How to do anything on your Mac, iPhone & iPad

=

GENIUS TIP

Import asset

At Pixelmator Pro’s launch screen, click
“Browse files on your Mac” to select a clip or still.
Here we can view our video clip by tapping the
Play icon. We shot our blue “alien” girl against a
green background.

Take a sample

As the green screen is unevenly lit some
parts are more transparent than others. Click the
eyedropper tool and then click to sample a
remaining section of green. More background
green pixels will become transparent.

Luminance range

Thanks to shadows on the background,
the brightness of the green curtain varies,
causing patches. We can include more variations
of green in our sampled color by dragging
the Luminance Range slider to the right.

Image rights: Apple Inc, Pixelmator Team.

When working with video
it's important to check the
background transparency
throughout the sequence.
Click the “..." icon by the
playhead and scrub through
the sequence.

Remove color

Press the "A" key to summon the Color
Adjustments panel. Scroll down to the Remove
Color tool to toggle it on. The tool is designed for
compositing, so the green background
automatically becomes semi-transparent.

Erase variations

To remove variations of green backdrop
from the clip, drag the Color Range slider to the
right. Note: if you drag it too far you may cause
highlighted areas on your subject (such as teeth)
to become transparent too.

GENIUS TIP

To remove green fringing
round the edge of the
subject, click the green
swatch in the Selective
Color panel and drag the
Saturation slider to 0.

Add background

The Intensity slider makes the green
background semi-transparent, so leave it at
100%. To composite our character into a new
location drag a background image on to a layer
below the clip in the Layers panel.
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Start journaling with Day One

Day One gives you all the tools to create multimedia journals

REQUIRES
Day One Journal app,
i0S 16 or later

YOU WILL LEARN
How to keep a digital diary

IT WILL TAKE
5-10 minutes a day

= JOURNALING IS A great way to
clear your head, organize your
‘ thoughts, and can really benefit
-~ your mental health. If you don’t
want to dust off your old paper diary, the
Day One app for Mac, iPhone, iPad and
Apple Watch can help you build a
multimedia journal, or even multiple
journals. You can include photos and text,
and the app can tag your location too,
mapping where you journal.
For a more authentic journaling
experience on iPad, Day One will accept

input from either an Apple Pencil or from a
third-party device such as a Logitech
Crayon. A free version is enough to get you
started, but the Premium tier ($34.99/year
via in—app purchase) offers cross—device
syncing, support for unlimited photos/video
and input via audio recording, among other
additional features.

Day One is very intuitive to start using,
but also offers plenty of features to explore
and use as time goes on, and could be a great
alternative to Apple’s Journal app, which
will arrive later this year. CHARLOTTE HENRY

HOW TO Journal with Day One

4B Reminders

[

Sign in to Day One

[ & Sign in with Apple J
Other aptions...

A" Appearance Lato System Fort S... »

Create an account

You need to create an account.
You can do that manually or simply sign in
using your existing Apple ID. Various other
options are presented the first time you
use the app — for example, whether you
wish to receive notifications.

34 | OCT 2023
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Add your first entry
Tap on the “+" sign at the bottom
of the screen and that will open a new
journal entry where you can start
putting your thoughts down. Day One
automatically records the date and time on
which you create an entry.

Start addlng photos

[t is not just text you can add. Tap
on the photo option to add pictures from
your Camera Roll that mean something to
you. Day One uses metadata from your
snap to record when and where it was
taken in your journal.

Image rights: Apple Inc, Automattic Inc.



[ Learn More

Use the Instagram Importer tool to save your social
posts to Day One

Connect Instagram Account

Auto-import all existing Instagram content into a new
journal: photos, videns, description, hashtags
[optianal).

Auto-updated with new Instagram posts,

Import your Insta

You can import your entire
Instagram account. Tap the gearicon
to open Settings, scroll to Instagram, then

tap Connect Instagram Account. Importing

photos can take a while, but new ones are
then automatically added.

Journal

8 2 T 30 1

ENTRY WEDTA DAY ATREAK OM THES DAY THiS WEEK

Get on a streak

To encourage you to add to your
journal regularly, Day One monitors how
many days in a row you have made an
entry. You can check your streak in the
blue toolbar at the top when in timeline
view (accessible in the bottom toolbar).

Sync across devices
Another great premium feature
is being able to journal across devices.
Open your journal on your Mac, iPhone or
iPad and everything from your other
devices will be synced across them when
you have an internet connection.

Image rights: Apple Inc, Automattic Inc.

How to do anything on your Mac, iPhone & iPad
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See your calendar

There are different ways to see
your journal entries. They are all accessible
from the toolbar at the bottom. Calendar
view is nice as you can see exactly what
you added on which day, just like a
traditional journal.

"Worth every penny"”

Ses why over 500,000 people have gone Premium

@ Unlimited photos and videos

Includes aute-importing from Instagram

Multiple devices

.El Start on your phone, finish on your iPad
or Mac

Unlimited journals
n’m A iournal for work. school, oratitude. family.

Time to upgrade

If you're in a journaling flow, it
might be time to upgrade to a Premium
account. Go to Settings > Account Status
and start the one-month trial. You can
always cancel if you don't want to
continue with a Premium subscription.

Set a reminder

To keep up your habit of journaling,
you can set a reminder. Go to Settings >
Reminders and set as many as you
want at whatever times are preferred.
The Advanced settings let you turn Apple
Watch notifications on or off.

fy 10
CITY.0F HAT
e LONDON

HAMMERSMIT
AND-FULHANM
=

Check your map

You can also see the map of where
you have journaled from by tapping the
Map option from that same timeline at the
bottom. The number in a blue circle on the
map shows how many entries you've
made from a particular location.

‘Monday, 12 June 2023 wvs Done

21:23 BST
‘)} 00:06, 9 Words, iPhone Micrephone, Londaon,
England

Journalling can be really good for your
mental health

Add some audio

With a Premium account you can
record audio entries too. Tap the Audio
button, press Record and both the audio
and the transcript get saved. You can
record for up to ten minutes and still
add extra text afterwards.

Selective Sync

L5
a
ra

W Journal 7

4
w
w

B Instagram

New Journal

Add new journals

A Premium membership allows
unlimited journals, so you can set up
a personal one, a work one, etc. Go to
Settings > Journals, then press the New
Journal option to create a new one and
pick settings like name and color.

0CT 2023 | 35



Create

Gamify your fithess
with Playfitt

Earn rewards as you push your fitness goals

REQUIRES
Playfitt, i0S 14 or later

YOU WILL LEARN
How to use Playfitt to build
a strong and enjoyable
exercise habit

IT WILL TAKE
10 minutes

>

GENIUS TIP

Playfitt rewards you for
exercising on consecutive
days. If you want to protect
your streak while you're
away, you can use a Streak

Saver token.
Tokens

0

S Baver

Boosters Buy boosters 3
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WE ALL KNOW that exercise is
P ’ hugely beneficial, not just for our
r physical capabilities, but
in terms of the positive effects it
can have on our happiness and mental state.
Yet turning exercise into a consistent habit
is often tricky.

Enter Playfitt. This app aims to build
exercise into a strong, lasting habit that
sticks with you. It does this by “gamifying”
your activities with goals, achievements and
rewards, encouraging you to keep coming
back for more.

How does this work? Simple: every time
you complete an exercise goal, Playfitt
rewards you with coins that can be spent
on real-world prizes like gift cards. It sets
you challenges and shows your place on
a leaderboard, tapping into the type of
competitiveness that helps habits form.
Before you know it, this approach will turn
exercise into something you want to do day
after day. It’s fun, satisfying, and free to

HOW TO Make fitness fun

o B

Today's moves

Y35  Squats St

e

You did it!

Weekly goals Seeall >

5;'

Maoves

start, while a premium subscription unlocks
extra rewards and faster progression.
ALEX BLAKE
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Weekly goals

Seeall >
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Moves

% Daily goals

" Goals that Playfitt has set you for the day
are on the Moves tab, with the reward shown
under each one. Swipe through to choose an
activity. Some (like steps) are measured
automatically; others are done manually.

O
&) O
o

) Get started

Choose a manually measured exercise
and tap Start. Here we'll do squats. This requires
you to put your iPhone in your pocket and listen
to the instructions. Playfitt logs your squats for
you as you do them.



You earned 400 coins

Pick a card to multiply your coins and win
other rewards.

F’. ;9 ;*

Coin rewards

Once you hit your target, you'll earn coins
from the app. Accumulate coins over time and
you can spend them on rewards such as gift
cards. Return to the Moves tab and you'll see your
goal has now been completed.

Boosters

Buy boosters to make all your movements worth
more. Get more trophies and climb leaderboards
faster,

Booster | Level 1

Spend your points

Once you've collected enough coins, you
can spend them on the Shop tab. You can pick up
boosters, which help you earn more rewards for
each activity, or exchange your coins for gift
cards and charitable donations.

Your stats
Week Month Year
Steps
1HE P
Stat history

On the Profile tab, select “See all” next
to "Your stats”. Here you can see your past
performances and filter by exercise type and time
period, and also see your rewards. Tap a bar on
the graph for specific metrics.

Image rights: Apple Inc, IntelliSports Inc.
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Weekly goals

0/56 completed

Introducing Challenges

Collect weekly bonuses to win big trophies and
unlock new Challenges.

35 Squats 15 Stair
1000 ¥ £98 1000%® k 1z
Weekly targets

Scroll to the bottom of the Move tab to
see your weekly goals. Tap “See all” to find out
how you're doing against your target. Each
exercise has several tiers, and reaching each one
lets you collect more rewards.

Leaderboard
alexblake
810
Trophies Boosters
Seeall v
1 8 Aisanicole © 1407
Get competitive

Playfitt also has a competitive element.
You can view your current ranking on the app’s
Leaderboard tab and move up through the ranks,
or invite your friends and compete against them
for points from the Friends tab.

Ace of Cups
Your cup overfloweth with trophies! All
those trophies earned you the Ace of Cups

badge.

Q

Breakthroughs

Your profile also shows the boosts and
upgrades you have earned (such as a streak
preserver), as well as your “breakthroughs”. Think
of these as achievements that mark
your progress, like performing 100 crunches.

Health

“Playfitt” would like 10 access and update your
Health data.

Tiam Off Al

¥F

GENIUS TIP

Playfitt doesn't sync all your
Apple Health data by
default, but enabling it in
the app’s settings lets the
app log more accurate
exercise data.

JARGON BUSTER

As well as coins, Playfitt
lets you earn trophies by
doing activities. The more
trophies you have,

the higher your
leaderboard ranking.

@ @00 Q)
Leaderboard
alexbiake
9 o (G
o G
m See ol v
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Use alternative
keyboards on iPhone

How to put many more options at your fingertips Alternative keyboards

Today, most iPhone users remain faithful to

REQUIRES WE TAKE ON-SCREEN keyboards Apple's built-in keyboard yet the App Store
A keyboard app installed A for granted but let’s pay tribute 18 pocked with gitmalivos iffeneg new
from the App Store; J to Ken Kocienda, a software Wtiye b G0 thinge: Jore:dliow docess T

or translate text. Others make apps easier
to navigate or speed up typing, putting more
power at your fingertips.

Microsoft SwiftKey (Free)
requires i0S 11 or later/
Gboard (Free) requires i0S

engineer at Apple for more
than 15 years. He worked on the iPhone’s
inaugural virtual keyboard and invented

12 or later keyboard autocorrect. For those used to
repeatedly pressing a physical key on a
YOU WILL LEARN mobile phone until the required letter

How to swap Apple’s default
keyboard for third-party
alternatives

was shown, it felt like progress.

Today, most iPhone users remain faithful
to Apple’s built-in keyboard, yet the App
Store is packed with alternatives offering
new ways to do things. Some allow access to
Al or translate text. Others make apps easier
to navigate or speed up typing, putting more
power at your fingertips.

But before taking the plunge, a warning.
Grant a third—party keyboard full access and
developers can potentially view what you
type. So always check the privacy policy
of a keyboard before entering sensitive
details, although many promise to only
store information on your device.

DAVID CROOKES

How this may sound to readers:

IT WILL TAKE

10 minutes

Confident sssns

Mo critical issues found

HOW TO Change your keyboard

£ Keyboards Keyboards Edit
Keyboards ;
English {UK)
English (UK
Text Replacement 9 (UK)
Emaji
One-Handed Keyboard J GIPHY
Grammarly
Add New Keyboard...
2 SwiftKey

Launch Settings

First, launch the App Store and
download a third-party keyboard. Then
open the Settings app and select
General > Keyboard. You can also edit
your keyboard preferences here —

toggle the buttons next to each option.

OCT 2023

Add new keyboard

Select Keyboards to see your
current selection. The top entry is the
one you're using, tap to switch between
different layouts (Qwerty, Azerty, Qwertz

and Dvorak). For third-party alternatives,

tap Add New Keyboard.

Third-party options

Select your pre-installed third-
party keyboard — once added, you may
need to tap it to grant full access. Now
go to an app that uses a keyboard.
Touch and hold the globe icon (bottom
left) and select your alternative.

Image rights: Apple Inc, Microsoft, Google Inc, Typewise.
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HOW TO Master Microsoft SwiftkKey

| @,

Number Row

Add a number row to your keyboard

Quiick Period

©

Double-tap the spacebar to insert a period

| @

Add a number row

Set up SwiftKey by tapping the
Microsoft icon above the keyboard. Tap
Settings, sign in, then choose Settings
to perhaps add a number row or revert
autocorrect when tapping backspace.
Or tap Themes for a fresh look!

Auto Capitalize

HOW TO Utilize Gboard

Detect Language <__> French

< Hellg| o >

T 23| 4| B|6&|F|8]8|0

giwile|lrltylulil|le|p

Translate/copy text

Want to type in a foreign
language but don't know the lingo? Tap
the Translate icon! Select the language
you want to translate to, type and tap
the arrow. You can copy text and review
it by tapping the Clipboard icon.

Q Search &) Tone (5)Chat [7] Compose

<  sortitout
Professional Casi
Please resolve this matter. Fix T
Use Bing Chat

The Al-powered Bing Chat has
been integrated with SwiftKey. Tap the
Bing icon and you can use Al to find
answers from the web, assess your text
for tone, and have a conversation. Use it
to write text for you.

£  Search settings

Contacts search

Turn on location access

Turn on location
services
Gboard lets you search Google directly
from the keyboard. Open the Gboard
app and, when Gboard's settings appear,
tap "Search settings” > “Turn on location
access’, allowing for localized searching.

Quickly swipe e
up F

Image rights: Apple Inc, Microsoft, Google Inc, Typewise.

BB A0 - © @

G search G Translate ©@ YouTube B®Maps
S At what time does the sun set? ¥
2, Weather ¥
9. Restaurants near me -f
=

Search Google

Now, when using the keyboard,
tap the Google icon. You can select one
of Gboard's suggestions or type your
own query. You can also look for
locations via Maps, find YouTube videos,
share contacts or translate text.

>KEY TO SUCCESS

OO0 280

Google
EMOJI GIF
o6
= "™
< football <)

B Quickly add a GIF

If you want to express yourself
with an image rather than words, you
can use a sticker, emoji or a GIF. Gboard
gives access to all three. Just tap the
icon above the keyboard and enter a
search term to see your options.

More alternative keyboards to write home about

Some alternative keyboard options offer extra benefits. Typewise Custom Keyboard
(www.typewise.appl helps to reduce typos by having larger keys aimed at two-
thumb typers. URL Quick Keyboard is perfect for quickly navigating through a web
address in Safari, while Grammarly (Www.grammarly.com) checks for gobbledegook

and improves your language. Phraseboard Keyboard (Www.phraseboard.com) lets
you store phrases so that you don't always need to type them in full, while ReBoard

(https://reboardapp.coml) integrates with many popular apps and is hugely flexible,
enabling you to customize layouts, fonts and more.
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Learn to draw on iPad

REQUIRES
ShadowDraw app
(Free, offers IAPs),
iPad0S 14.3 or later

YOU WILL LEARN
How to create
accomplished drawings

IT WILL TAKE
30 minutes

=

e

GENIUS TIP

Some of the lessons here
are quite fiddly, but you
can pinch and stretch
your fingers to zoom in
and out to make things
much easier.

0CT 2023

- THE MAIN THING that prevents us

(S \ from being global art superstars

IKZ} is, well, our complete lack of

drawing skill! ShadowDraw

promises to help with that. If, like us, you’ve
always wanted to draw but haven’t been
taught how, or if you just don’t feel very
confident, it’s a great way to bring out your
inner Degas or Diirer.

The app is designed for absolute
beginners, and it takes you step by step
through the process of turning an idea into
an artwork. Rather than tell you how to

Monthly 'T'}

i;é ey
The most cost-effective way to use ShadowDraw is with
a subscription. There's a free seven-day trial.

draw something, it shows you; you’ll see
the pen or brush strokes of an artist on
your iPad’s screen, and you learn how to
draw by copying the artist’s own moves. Get
it right and you’ll move on to the next bit;
get it wrong and you’ll be gently guided
towards the correct positioning.

ShadowDraw is a free app, but monthly/
yearly memberships, as well as individual
add-on packs for particular kinds of
drawings, are also available. A guide to
drawing kittens, for example, is $1.99; it’s
also $1.99 for a guide to illustrating really
angry cats, and you’ll pay the same price for
a guide to drawing many artists’ least
favorite body part: hands.

If you’d rather pay a flat subscription,
ShadowDraw is $7.99 per month or $49.99
per year. It supports Family Sharing so you
can share the full library — up to 1,000
guides — with up to five other family
members. We’d say the subscription option
will work out more economic in the long
run. The app is really easy to get started
with, so let’s do just that...

CARRIE MARSHALL
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HOW TO Improve your drawing skills on iPad

o 33 e Sascasinn

[OF=]

Choose a section

The front page of ShadowDraw is
organized into sections, with free lessons
at the top and paid-for courses below.
While there are lots of courses for more
experienced artists, we're going to start
with the basics via Learn The Basics here.

L] L]

Do it your way

It's hardly Van Gogh's Sunflowers,
we know, but having drawn our first flower
we can now share our artistic genius with
others, repeat the lesson or play with our
drawing. Let’s do that last one. Tap on Add
Personal Touches.

2 @
At Teacher Mode Sketch My Way
b alors

L the colars prd ant -
toels pre sefd ctad for you g
oy e et faachar

Pick a mode

There are two modes you can use
here. Art Teacher Mode chooses the
brushes, pens and colors for you; Sketch
My Way enables you to pick your own tools
and colors. We'll stick with Art Teacher
Mode for this one.

Image rights: Apple Inc, Shadow Draw Inc.

Emcinsen Yoo Lobe Intrnchrctizn

Pick your lesson

As you can see, there are lots of
introductory lessons here. Let's go with
the simplest one, which will show us how
to draw as well as teach us how to use
ShadowDraw's key features. Tap on Start
Drawing to begin your first lesson.

& °

v . o [ 1 2
= F L 1]
Enhance your art
As you can see, the drawing
remains on screen but we've been able to
use the drawing tools to add flourishes:
simply tap on the tool you want to use and
on the color. The “." icon provides access
to more detailed controls.

(=] L]

Follow the teacher

This time the lesson isn't about
creating a finished drawing; it's about
understanding the different bits of a body
and how they connect. The app outlines
each key area as a circle or a line and your
job is to copy each one.

See and repeat

ShadowDraw doesn't tell you how
to draw; it shows you. Each image is
broken down into single-stroke steps, and
you simply draw on top of the turquoise
lines. When you do, the guide lines vanish
and the app draws the next step.

Get more advanced

Tap on the check mark (top right)
to return to the menu. This time we're
going to pick something a bit more
involved, which is figure drawing. Before
ShadowDraw gets you to follow it, it shows
you what you're going to be producing.

S e i P 3

k
&

Cours de Dessin: Plate |, 9

A
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Get seriously arty
We've focused on absolute
beginner lessons here, but ShadowDraw
can teach you much more advanced
drawings — for example here you can do a
masterclass in form and shading. These
advanced courses require a subscription.
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Danny’s
Apple Watch
With You

Danny’s
AirPods Max

San Francisco, CA

Master the Find My apps

Find people, iPhones and AirTags on your Apple Watch

REQUIRES
Your Apple Watch,
some things to find

YOU WILL LEARN
How to set up and use
Find My apps

IT WILL TAKE
10 minutes

=

GENIUS TIP

Can't find your Apple
Watch? Find My can locate
that too. If your iPhone
isn't handy you can use

to locate

your missing Watch.

42 | OCT 2023

NO PUN INTENDED, but we’ve
lost track of the number of
times the Find My app has
helped us locate lost items or
warned us of items we’ve left behind. From
errant AirPods to misplaced iPhones and the
odd AirTag-enabled wallet, purse or bag, the
Find My apps have saved us a great deal of
stress and probably a lot of money too.
Your Apple Watch has three apps that use
Apple’s Find My service: Find Devices, Find
Items, and Find People. They all use Apple’s

The new Check-in feature in i0S 17 can automatically tell
friends or family when you arrive at a particular location.

Find My network, which is enormously
clever; whenever your device or AirTag is
within range of an Apple device, it sends an
encrypted signal to Apple via the device’s
Bluetooth connection. The other device
doesn’t see the signal; it just passes it on to
Apple — and when you activate the Find My
app, the app simply asks Apple “hey,
where’s that device?”

SOUNDS AND WARNINGS

When you locate a missing device, the apps
do several things. They tell you where it is or
where it was last located, enabling you to see
that location in Maps. They enable you to
play a sound to help you find it if it’s nearby,
or alert others in the area. And you can use
the apps to warn you if you leave a particular
item behind. We have an AirTag in our bag
for exactly that reason.

In this tutorial, we’ll show you how the
three Apple Watch Find My apps work, and
what they can and can’t do across all kinds
of Apple devices and accessories.

CARRIE MARSHALL

Image rights: Apple Inc.
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Locate your stuff with Find My

' Fantastical

0 Find Devices

Find Items

0 Find People

( ! Heart Rate

A Find the finders

I The Find apps on your Apple
Watch are the sensibly named Find
Devices, Find Items, and Find People
apps, which share the same icon colors
but have different images. We'll start
with People first, so let’s tap that icon.

(&) Contact

» See where they are
W We've blacked out the details for
privacy here, but trust us: this screen
shows the exact location of our child on
a map as well as details such as the
approximate house or flat number,

the street name, and the postcode.

21:53
wd C pruas W

Giasgow, Scotland

Carrie's Keys ’

Glasgow, Scotland

Carrie's @
Marauder

A Find your keys

S Not to worry — we've got an
AirTag on our key ring too. Knowing the
location isn't really helpful here — just
because we're in the same building as
our car keys doesn't mean we know
where they are. Apple has a solution.

Sophie

Glasgow, Scotland

Now

Adam
Marshall

No location

) Locate a person

»7 In order to find a person, they
need to be sharing their location with
you. Here we have two family members;
because we use Family Sharing, we can
enable location sharing in the Family
control panel on iPhone, iPad or Mac.

) Get directions

" If you want to find that person,
scroll up until you see the Directions
icon (immediately under Contact). This
will bring up info from Maps telling you
how far away they are, how long it'll
take, and what the traffic is like.

- Play Sound
‘ Off

-, Directions

Notify When Found

Make some noise

" In both the Find Items and Find
Devices apps, you can play a sound to
help locate an item that's within range
but not visible — so you can get the
AirTag on your keys to announce where
it is, or make your iPhone ping.

Allow “Find People” to
use your location?
Your location will be
used to show your
location on the map

and see how far away
your friends are.

% Share yourself

™" The first time you use one of the
Find apps on your Watch, you'll be asked
whether you want to use your location.
Say yes to this request, because any
direction-based information needs to
know where you are.

Carrie @
acoustasonic

With You

Now

Carrie pedals @

Glasgow, Scotland

05

* ) Find lost items

W Find My works with AirTags too.
You can use AirTags on musical
equipment, say. As you can see here
we're in the same place as our guitar
and pedals. That's fine with something
big, but what if you lose your car keys?

Motify When
Left Behind

A Learn the lesson

E If like us you're prone to
forgetting things, you can set the Notify
When Left Behind toggle for individual
devices or people — so if you go out
without your bag or keys, you'll get

a notification on your Apple Watch.
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End-to-end encryption

The gold standard for security and privacy? But what exactly does it offer?

J A~
5-| HOWIT | '
" WORKS ')

YOU WILL LEARN
What end-to-end
encryption does, how it can
differ between apps, and
why it's not always welcome

ENCRYPTION
USES KEYS TO
SAFELY LOCK
DATA AWAY BY
CONVERTING

ITINTO A
RANDOM CODE

KEY FACT

If you want to use end-to-
end encryption in Facebook
Messenger, you'll need to
use your iPhone or iPad
and begin a secret
conversation. Start a chat
in the usual way but toggle
the lock icon in the top-
right of the screen. You can
then choose who you want
to message, but bear

in mind that these
conversations can only be
viewed via i0S, iPad0S

and Android.

44 | OCT 2023

PSST! WANT TO know a secret?
n Then jump on to a messaging

service that has end-to-end

encryption so we can discuss it
more discreetly. Don’t worry, nobody can
intercept what we share. End-to-end
encryption (or E2EE) means that only those
allowed to join the chat can access
messages, with third parties prevented from
reading any sensitive data and there being
no fear that documents will fall into the
wrong hands.

If that sounds too good to be true, then
let’s make one thing clear. E2EE is of great
importance to anyone who values their
privacy. It’s used by WhatsApp, Signal,
Proton Mail and many other apps and
services, protecting your data from
cybercriminals, hackers and snoopers. It
ensures data sent by a user remains secret
until it reaches its intended endpoint —
which, in the case of a messaging app, is
another user’s device.

Not that E2EE is limited to messages.
Banks use it, as do many other businesses.
Apple also understands the benefits of E2EE
for storage, which is why it offers a setting
called Advanced Data Protection. Use it and
you can encrypt the majority of iCloud data
end-to-end with the exception of the
Calendar, Contacts and Mail apps. Data can
only be decrypted when you’re signed in
with your Apple ID on your trusted devices.
It’s scrambled on Apple’s servers.

PRIVATE EYE

But just how does it work? In general,
encryption uses cryptographic keys to safely
lock data away by converting it into a
random code. Such code can only be
converted back into its original state by
using the correct key and this allows you to
encrypt data on a computer, phone or tablet
or send scrambled info to other devices or
cloud servers via the internet.

The important thing is who has access to
the keys. If, say, you’re using Google Drive,
you’re allowing Google to keep hold of them.
Any files you upload to its cloud server will

16:40

< iCloud Advanced Data Protection

Advanced Data Protection

iCloud encrypts your data to keep it secure.
Advanced Data Protection uses end-to-end
encryption to ensure that the iCloud data types
listed here can only be decrypted on your
trusted devices, protecting your information
even in the case of a data breach in the cloud.

Learn how encryption is used.

Because Apple will not have the keys required
to recover your data, you will be guided through
verification of your recovery methods in case
you ever lose access to your account.

Device Backup Reminders
| Messages Backup &) Safari Bookmarks
iCloud Drive - Siri Shortcuts

Notes . Voice Memaos

Phaotos E Wallet Passes

Turn On Advanced Data Protection

You will be able to encrypt iCloud Drive, Photos,
Notes, Messages Backup, Reminders and more with
Advanced Data Protection for iCloud.

be encrypted with AES-256 (a strong
symmetric encryption algorithm which
prevents third parties from snooping), but
it’s possible for a Google worker to unlock
and decrypt your data.

Store files in iCloud using Advanced
Data Protection, however, and the situation
is different. Apple will still encrypt your files
but it won’t have the keys to decrypt them.
That’s because E2EE comprises a set of
public and private cryptographic keys. After
users sign up to a service that makes use of
end-to—end encryption, a public key is
generated and saved onto the service’s



> WHAT DO GOVERNMENTS THINK ABOUT END-TO-END ENCRYPTION?

There is growing pressure on
companies to weaken end-to-end
encryption systems. Policymakers
would like services that use the
technology to scan messages in order
to identify and remove material related
to child abuse. It could also prevent
terrorists and other bad people from
using end-to-end encryption to hide
their activities.

In the US, there are three bills before
Congress: the STOP CSAM Act, the
EARN IT Act, and the Kids Online Safety

Act. In general, they seek to make
companies, non-profits and individuals
liable for harmful content being shared
in an encrypted environment and
could see the end of end-to-end
encryption. Yet while there is support
for such measures, some groups,
including the Internet Society, argue
that the bills, if passed, would make
the internet less safe. Similar
measures against E2EE are also being
taken in other countries: the UK is
considering the Online Safety Bill.

End-to-end Encrypted Backup is Off

If you open your WhatsApp settings, tap
Chats and Chat Backup, you can turn on
E2EE backup when saving your archive to
iCloud or Google Drive.

End-to-end encryption

Proton Mail says end-to-end encryption protects
against data breaches and it promises no-one
else will be able to read your messages.

server. A private key is also created and this
is stored on the user’s device. The idea is
that no—one other than the user can access
that latter key. This works particularly well
when sending messages: the recipient’s
public key is used to scramble the data into a
long series of digits and the recipient’s
private key is then used to unscramble the
information so that it can be read on the
recipient’s device. If anyone managed to
intercept the data during its journey, they
would be faced with gobbledegook and have
no means of making sense of it. Crucially,
since the service providers themselves don’t
have the private key, they can’t read it
either — they simply don’t have access.

But that’s not all. Services including
Signal, WhatsApp and Facebook Messenger
use the Signal Protocol developed by Open
Whisper Systems and this includes the
Double Ratchet Algorithm developed in
2013. It generates temporary keys whenever
a new message is sent providing an extra
defense mechanism. Hackers somehow

gaining access to a private key would be
limited to decrypting just one message. It’s
incredibly secure.

PICKING HOLES

So why isn’t end-to—end encryption
standard? Well, that is a question for
developers, although there are legitimate
reasons. Google, for instance, will read
messages to pick out contextual data such
as a calendar entry, or scan emails for
potential spam.

But there are some odd situations such
as Meta offering E2EE by default in
WhatsApp (and recently introducing the
ability to verify E2EE backup passwords for
additional security) while forcing Facebook
Messenger users to start a secret chat for the
same benefits. What’s more, there are
different levels of E2EE. Pay for an X
subscription, for instance, and you’ll be able
to send encrypted direct messages, so long
as they don’t contain media and other
attachments or form part of a group chat.
Metadata is not encrypted either so
information about the date, time, who is
involved and so on is not concealed. “When
it comes to Direct Messages, the standard
should be, if someone puts a gun to our
heads, we still can’t access your messages.
We’re not quite there yet,” X states.

Still, it’s a step in the right direction and
E2EE is certainly proving vital for anyone
concerned about privacy and security. If you
don’t want others snooping on your data,
there is no better way.

DAVID CROOKES
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KEY FACT

To make use of Advanced
Data Protection for iCloud
and use E2EE, you will need
to update all your devices
(you'll need at least i0S/
iPad0S 16.2 and mac0S
13.1). Open the Settings app
on iPad (or System Settings
on Mac), select your name
and tap iCloud. Now choose
Advanced Data Protection,
turn it on and set up your
recovery methods to avoid
being locked out.
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\ Our resident genius
; Howard Oakley solves
your Mac and i0S problems

TECH SUPPORT & TECHSPLANATIONS

A missing key in virtual macOS

BRITISH AND US ENGLISH there’s a more “sinister” the difference you’ll notice is that
e are so different they difference, as the ISO keyboard missing key: in ISO English

require separate has an extra key at the left layouts, it won’t cause a problem,
keyboards: ISO in the UK, and of the numbers. as that provides § and + symbols.
ANSI in the US. They’re easy to Apple supplies ISO keyboards But in French, the ANSI layout
distinguish as the ISO version, and layouts for many languages, loses @ and #, which are
commonly used in Europe, has but macOS virtualization for Apple = commonplace in computing,
different Shift and Return keys. silicon Macs is an exception as it and make a virtual machine
Count the keys, though, and only supports ANSI. In practice, almost unusable.

> Blocked email accounts

My ISP says it's going to block basic authentication, so | can’t collect my email using an app on my
Mac, but have to use its web interface. How can | keep my local mailboxes?

Some ISPs are telling those with

e M~ < ® 0 § outlook.office.com -
bundled mail facilities that this
authentication block is being done © Hame | Micrasoft 385 o £mail - Howard Dakley - Outlok
by Microsoft to improve mail
service security. Authentication
using a username and password Settings Layout Forwarding
has been replaced with modern | 2 search settings | compose and reply s e tornand inor il e snaticrsccoust
authentication, typically OAuth2. ' I i (it
That requires your mail client to & Geers e W e vty
run a one-time setup with the mail =1 el _ oo Lo i
server, so it can log in and fetch fEl Calendar oo | Powardcakleyi@macformiatco.ul
your mail using either POP or IMAP, & Peosie Qick steps [ i o Ve
and send using SMTP. But those Customise actions
providers aren’t enabling that to let Sync email

Microsoft's own Outlook 365 or
clients like Postbox collect their
mail securely. Instead, the only
services they're supporting are
webmail, or Outlook on i0S/iPad0S. Retention policies

The best workaround is to set up Groups
accounts with another mail
provider like Gmail or Titan, and set
your original mailboxes to forward
email to that account, from where
you collect and read them using
your email client. That's easy to
configure in Outlook’s webmail, “ Discard
although you'll still want to check
your original mailbox on the web
from time to time. If your provider only allows web access to email, set it to forward everything to another account to collect it from.

Message handling
Forwarding

Automatic rephes

46 OCT 2023 Image rights: Apple Inc.



Tech Support & Techsplanations

EMAIL:EsK@maclife.com 1fae®
SHARE WITH US! FACEBOOK:[facebook.com/maclite] TWITTER:[Ewitter.com/maclitel Mac | Llfe.

Get official documentation at[support.apple.com]|| Get help with hardware at[support.apple.com/repain

> Export your
Health data to
a spreadsheet

How do | go about
downloading details of my
daily walking distance from
the Health app so | can turn
the info into charts?

The Health app only provides a way to
export all your data in formats
unsuitable for spreadsheets. To use
that, tap on your user picture at the
upper right of the Summary, then on
Export All Health Data. The app can
take several minutes to prepare those
files, and you can then AirDrop them to
your Mac or another device, or save
them to iCloud Drive. As they contain
personal data, you may wish to protect
them using encryption. In addition to
ECGs and workout routes, there will be
two large XML files containing all the
data that the Health app uses to create
its charts. Finding an app to then

do anything useful with those is more
of a challenge.

To make your own charts using
Numbers or another spreadsheet you
need a simpler summary of just the
data you want in CSV format, available
from Tomas Pafizek's HealthExport app
(https://healthexport.app). Once
you've given permission for that app to
access your data, select the data you
want it to export; in your case, thisis an

“aggregated” type listed as Activity. This can
include distances covered by walking, cycling,

£ Choose dates

Export

Share CSV

Distance walking [ running
mi

nimb F ro ok i
Number of records Sun

31 256.769

St. deviation Median

0.807 8.182

Minimun Maximum

6.36 10.228

10 15
B Distance walking / running

o0 900 v -

Preview your Health data before HealthExport shares it in
CSV format, to import into your preferred spreadsheet.

Quick-fire
questions
& answers

WHY WON'T MY iPAD
CONNECT TO THE
APP STORE?

Ensure your device has
a good Wi-Fi
connection. Shut it
down, and wait 30
seconds before starting
it up again. Then check
in Settings > [your
name] that it's signed in
correctly with your
Apple ID. If those are
good, check service
availability athttps:77]
lapple.co/3005278

HOW TO TELL WHICH
APPS TRACK MY
LOCATION?

Tap Settings > Privacy &
Security > Location
Services to see a list of
all the apps you've
allowed to access your
location data. To tell
which apps use that
data the most, those
that have accessed
location in the last 24
hours are marked with
gray arrows, and those
that have accessed it
most recently have
purple arrows.

2274 r -

£ Back Lecation Services
W o0& asanan

exercise time, and more. 2 :::TV
Then tap on the “Export aggregated data” previews of the data being exported, and you B The s
button and select the date range and period can send or save the CSV file as you need, G Topo Maps
such as days. The app provides graphical so you can open it in Numbers or Excel. £ e Tome
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Quick-fire
questions
& answers

WHICH PRINTERS
ARE SUPPORTED BY
MACOS VENTURA?
Macs can print to
all those with full
AirPrint support.
Apple maintains a
list of AirPrint

devices at[bitp.—s;lL]

| apple.co/SKwzafV |
including a dozen
AirPrint-enabled print
servers, and some that

connect via USB only.

CANICONNECTA
USB-C HUB TO MY
STUDIO DISPLAY?

Yes, but you may prefer
not to. It has three
USB-C ports supporting
up to 10Gbps, and three
snags: these don't
support faster USB 3.2
Gen 2x2 speeds, and
all are fed through

one Thunderbolt 3
connection with your
Mac. They're active all
the time the display is
plugged in, but power
down briefly whenever
the connected Mac
shuts down.
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Mac Hardware

We're here to help solve your hardware issues

> Connect an enterprise U.2 SSD

Canl connect a U.2 SSD and use it with my Mac?

Many U.2 and U.3 SSDs are coming onto
markets like eBay at present because
enterprise users, who have relied on them in
their servers, are getting rid of them as they
are end of life and need replacement. Models
like Samsung’'s PM1733 originally cost over
$1,000 for 15TB storage and speeds of over
7GB/sec. They present challenges connecting
them to Macs.

Some may have had hard working lives.
Although Samsung claimed that they “never
die”, they do still age, and those in heavily

loaded servers may be nearing their end of life.

If you can, read its SMART indicators before
spending any more money on it.

If you happen to have a 2019 or later
Mac Pro, you can buy an add-in PCle card for
it with U.2 support. For all other Macs with
Thunderbolt 3 ports you'll need a special

enclosure with a suitable power supply
and active cooling, otherwise they’ll get
exceedingly hot, suffer thermal shutdown
and stop working. An OWC Mercury Pro U.2
Dual enclosure at around $230 is ideal, and
accommodates a single U.2 SSD in each

of its two bays. You can also populate an
OWC U2 Shuttle carrier with up to four

M.2 SSDs, and use that instead.

It's also possible to put together a string
of adaptors to make the connection, including
a U.2 to M.2 adaptor, an M.2 enclosure, and a
supplementary 15-pin SATA power adaptor,
but in this instance you'll then need to
provide your own cooling fan.

Enterprise SSDs in U.2 and U.3 formats
require the right connections and power supply,
and good active cooling or they won't work.


https://support.apple.com/en-gb/HT201311
https://support.apple.com/en-gb/HT201311

Try resolving problems with external displays and Intel Macs by disconnecting them and resetting the SMC and NVRAM.

> External displays stuck in standby

After updating Ventura, my Intel iMac’s two external displays refuse to
come out of standby mode. How can | fix them?

Problems connecting to displays aren’t easy to
resolve as they should just work automatically,
and there are precious few controls.

First shut your Mac and both displays down,
and disconnect their cables from the ports on
your Mac. Then start your Mac up and reset its
NVRAM and SMC according to the instructions
detailed at https://bit.ly/3rWIdypl Once your
Mac is up and running again, power up and
connect the first external display. Hopefully
that will appear in System Settings > Displays,

> Self-disconnecting SSDs

Why do some USB 3.2 SSDs connected through a Thunderbolt 3 dock

where you can set it up. After that, repeat the
process with the second display.

If that doesn’t work, consider changing
the cables connecting the displays to your
Mac for better-quality branded ones, or
changing any settings offered by the
displays, if that's possible. If you still
can't have any luck with them, contact
Apple Support, who may be able to
escalate this to someone who can do
something about it for you.

Quick-fire
questions
& answers

HOWTO
DEFRAGMENT AN
APFS EXTERNAL
HARD DRIVE?

The Apple File System
has its own support for
defragmentation, and
no third-party utility is
available. This doesn't
help fragmentation of
the file system
metadata itself, though,
which is thought to be
largely responsible for
slowing access to the
hard drive.

CANIUSE ATOUCH
ID KEYBOARD WITH
MY INTEL MAC?

No, only Apple silicon
Macs. Intel notebooks
with T2 chips have
built-in support for
Touch ID on their
internal keyboards,
but even they can't
supportitinan
external keyboard.

suddenly disconnect themselves from my Mac?

i

There are two main issues to focus on:
cables and sleep. To connect to
Thunderbolt 3 ports, cables should
have a positive click to lock them home
at both ends, which some USB-C
cables don't have. The sockets on
some external drives don't provide this
either, and don't give confidence in
their connection. Careful selection of a
Thunderbolt 3 or 4 cable should

provide a more positive feel and ensure
that they don’t drift. It can be worth
trying several different cables until
both connections are secure.

Sleep is a little more tricky, and it's
worth observing carefully whether this
disconnection occurs when your Mac
goes to sleep or wakes up. If there is an
association, use Ohanaware’s Sleep Aid

from https://ohanaware.con to fully

investigate what's going wrong to
cause this.

Some SATA enclosures need
firmware updates for them to become
reliable with recent versions of
macOsS, so it's worth checking with the
manufacturer’s support site to find out.
If you still can't avoid these sudden
disconnections, it could well be that
the SSD is faulty and needs replacing.
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@ Ask

®

mac0S

Shine a spotlight on the solutions to
your most irritating Mac problems

> Customize your apps

How much can | customize an app in Ventura without breaking it?

In the case of third-party apps you've
installed, it's perfectly safe to change
theiricon and name, but little else. Look
inside an app and you'll see it's a
“bundle” consisting of a single folder
named Contents. You should avoid
tampering with anything inside that, as
that would risk breaking the app’s
signature, so rendering it unusable:
every time you'd try to open it, macOS
would crash it deliberately because the
hash fingerprints of its code files no
longer matched those baked into its
signing certificate.

Giving it a differenticon can
be performed safely by pasting a
replacement image into the existing
place at the top left of the Finder's Get
Info dialog, which saves that icon into
a hidden file named “lcon?” outside its
Contents folder. You can also change its
name in the Name & Extension section
below, but don't try changing its
extension as that too will cause
problems. You can of course lock it and
add tags and comments as you wish.

Apps bundled by Apple within macOS
are baked into the system and can

neither be changed nor copied
elsewhere. The latter is the result of
launch constraints introduced in
Ventura, which mean the only place a
bundled app can be run from is where it
is in the macOS System volume.

Customizing app icons and names can have
practical value should you need to run two
copies at the same time.

> mac0S updates have changed

How do | obtain a “Combo” updater for Ventura 13.5?

Since Big Sur, macOS installers and updaters have been
quite different from those of the past. Instead of just
copying across system files to a volume on your startup
disk, they now have more work to do to create the
snapshot that forms the bootable system, to firmlink
parts of that to its paired Data volume, and to secure
the whole system using hashes to verify its integrity.

From Big Sur onwards, Apple has provided only two
ways to update macOS: online updates, delivered
through Software Update or its command-line
equivalent, softwareupdate, or using a full installer
app. Updates completed online automatically cater for
different starting versions, so they can take any
previous version of macOS 13 straight to the latest
version, but that's the only destination available.

Combo updaters of the past sometimes fixed
problems with broken updates. That's no longer
necessary, as the hash system used to verify the
integrity of the system ensures that it's perfect down
to the very last byte.

What you can do instead is install the macOS version
of your choice. Those available can be listed in Terminal
using the command

softwareupdate --list-full-installers
and you could download the full 13.5 installer using

sudo softwareupdate --fetch-full-installer --full-
installer-version 13.5
then entering your password. You'll get an installer
package containing the full installer app for macOS
Ventura 13.5. Apple guarantees the result is identical to
updating from any previous version of Ventura.

- existing
4 installation
/when you select
that at the disk

to be'used.
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SHARE WITH US!

Quick-fire
questions
& answers

macOS Ventura
HOW TO RESET A
Select a user to set as owner of the new volume:
FORGOTTEN
FIRMWARE
PASSWORD?

& Copy account settings from Howard Oakley

Back

Install

For an Apple silicon Mac to be able to start up from an external disk, you need to assign ownership during macOS installation.

> Keep two versions of mac0S

How can | keep Ventura available on my M2 MacBook Pro

when | upgrade it to Sonoma?

The best solution depends on what you still
want to be able to do in Ventura. If you want to
run App Store apps, access iCloud or do
anything else dependent on your Apple ID,
then the only way to keep access to an older
version of macOS is to install it on your Mac's
internal or an external drive. If you don’t need
those, then it’s quicker and simpler to run
Ventura in a virtual machine (VM).
Dual-booting between different macOS
can prove tricky to set up, and some find it
unreliable. While you could install both on your

Mac's internal SSD, if anything goes wrong it
could put your primary Sonoma system at risk.
Running Ventura from a bootable external SSD
is safer, but requires assignment of
“ownership” to that disk for it to become
bootable (detailed at https://bit.ly/30Khpvd).
If you can live with the limits imposed
in a VM situation, you could use Parallels
Desktop, UTM, or the free Viable from
Performance is near-native,
you don't have to restart into Ventura to use
it, and it’s really convenient.

The only way to remove
or change a firmware
password is in
Recovery, and requires
you to enter the
firmware password. If
you can't do that, take
your Mac with proof

of ownership to an
Apple Store and get
them to remove the
password for you.

HOW TO COPY TIME
MACHINE BACKUPS
TO A NEW DRIVE?

If your backups are
made to APFS, you
can't copy or move

its backups from

that storage because
they're snapshots that
can't be copied to a
different volume.

You can still copy
backups from older
HFS+ volumes.

HOW TO STOP APPS SAVING OLD WHY CAN'T SPOTLIGHT FIND soe
VERSIONS OF DOCUMENTS? ANY APPS ON MY MAC? ; o
There's no control to do this, although some It's likely that you've inadvertently disabled that D e
apps might offer it in their Settings. One from its results. Open System Settings and i
potential workaround is to delete the hidden select Siri & Spotlight. In the Search results ::m
folder named .DocumentRevisions-V100 on the | section, tick Applications. As Spotlight should e
volume storing your documents, and replace it still have been indexing your apps even though :’:ﬂ’"‘
with a locked file of the same name. This could it wouldn't return any results, that shouldn't s
cause other problems, though. require any re-indexing before it works fully. IR

Image rights: Apple Inc.
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roadcast

yourself!

Calling all influencers! With some hardware, software and a
little know-how, you too can become a YouTube superstar

WRITTEN BY CARRIE MARSHALL / ARTWORK BY GRACE MORRIS

he artist Andy Warhol
is famously quoted as
saying thatin the
future, everybody will
be famous for 15 minutes. He
got the number right and the
unit wrong: today, everybody
can be famous for a mere 15
seconds, with short-form
content on the likes of TikTok
earning creators viral fame.
There's been an explosion of
people uploading music, video

3 é\’.\

and podcasts for audiences to
stream live or listen to at their
leisure, a huge increase in
places to share content, and a
whole new world of hardware
and software to help make the
most of it. It's never been easier
to share on social media

— although making money from
itis more difficult. But money
isn't the only reason to
broadcast yourself. It's a lot of
fun, and you never know where

your clips might take you.

Over the next few pages we'll
discover the hardware, software
and hosts you need to get the
most out of sharing. We'll look at
the gadgets and apps that do all
the difficult stuff for you,
editing your video to make it
pop. and how to look good on
camera. Although we'll mainly
be talking about the Mac here,
lots of the kit, apps and advice
apply toiPad and iPhone too. m

Image rights: Apple Inc.



Image rights: Sony Europe BV, Native Instruments GmbH, Logitech, Elgato. OCT 2023 | 53



@ Feature

What you

will need

irst things first, in order
F to turn your bright ideas

into something others
can see or stream, you're going
to need a few items of both
hardware and software.

The hardware you need
depends on the content you
plan to make and where you'e
going to put it. For example, you

Choose a Session Template

New Blank

can make videos for TikTok or
Instagram reels with just an
iPhone and Apple's free Clips
app. and you can also get iMovie
for free in order to access more
professional tools, such as
effects and editing. You can
record a podcast directly into
GarageBand and use its built-in
effects to make it sound great,

Template Chooser

If you're recording podcasts, Audio Hijack makes it easy to bring in Zoom
or FaceTime guests, record multiple mics, or capture any Mac audio.

You don't need to spend a
fortune on studio-quality
equipment, but there are
some upgrades that will
make a huge difference.

A good-quality mic, a warm
white light, or a decent
video camera will seriously
improve the quality of

your content.
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$49.99
A USB microphone can plug directly into your Mac or
a recent iPad and, with the right adaptor, you can
use it on Lightning iPads and iPhones too. Designed
for podcasting and streaming, this Snowball Ice
desktop mic is a huge audio upgrade over the built-

in mics on your Mac.

and if you want to record people
over Zoom or FaceTime there's
our old favorite Audio Hijack,
which can record pretty

much any audio that plays

on your Mac.

The mostimportant part of
your setup is the hardware that
records your sound or your
video. For podcasting or
voiceovers that means a good-
quality USB microphone to plug
directly into your Mac (or your
iPhone or iPad via USB-C or
Apple’'s USB to Lightning
converter); or a non-USB
microphone connected via a
USB audio interface such as
a Focusrite Scarlett Solo,
M-Audio M-Track Solo, or
a Komplete Audio box.

For video, if you have a
reasonably recent iPhone then
its camera is better than many
budget cameras and almost all
webcams, and if you have

$149.99

@ OBESSwdic Fis Edit View Docks Profile  Scene Collection  Took

[ Dispiay Capture

T Soenes

Scene

OBS Studio is one of the
most popular video
recording and streaming
apps. It takes a bit of
learning, but it's very
powerful.

macOS Ventura and i0S 16 or
later you can use Continuity
Camera to make your iPhone
work as a webcam for any
video app.

If you're a fan of gaming or
other video streamers, you
might have seen the Elgato
Stream Deck on the streamer’s

Turn your Mac into a radio or TV studio with this
brilliant little add-on. You can program its 15 LCD
keys to play jingles and stings, control your lighting,
play back recorded audio and pretty much anything
else media-related you can think of. No wonder
video influencers love it so.

Image rights: Apple Inc, Logitech, Elgato.
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desktop. That's an interface
designed specifically for live
streaming, and it features 15
programmable LCD keys you
can use to control your video
app, trigger audio effects,
adjust your audio, control
smart lights and more, and
there are over 100 plug-ins for

$34.95

Ring lights with adjustable color temperatures are
the little secret of big-time social media streamers;
put it in front of your phone and it'll bathe you with
flattering light. It's handy for work video calls and
taking selfies too. This ring light from Joby features
ten brightness levels and three color temperatures.

specific streaming platforms
and hardware.

For recorded audio and video
you can simply export your
completed content and upload
it. But for live streaming you'll
need an app. There are lots to
choose from, and one of the
most popularis OBS Studio.

LR R

Effuct Filters

@ Colour Correction

and customizable.
|
|

That's free and open source,
and if you're willing to take some
time to find your way around

it's enormously powerful

You don't need OBS Studio
to live stream; if you have a
YouTube account, you can tap
on the Go Live button (although

indo: Settings anty apply to SDRidea,

Setect colour

‘Start Streaming
Start Becording

Start Virral Camara

Srudio Mode

when you first go to use it, you'll
have to wait 24 hours for
authorization), and Twitch has
the Twitch Studio Beta app. But
the benefit of learning OBS
Studio is that if you change
where you stream, you don't
need to learn a whole new
apptodoit.m

$899.99 | https://electronics.sony.com|
It's not cheap, but Sony’s ZV-111 photo and video

camera has been specially designed for vloggers and
podcasters and will make you look and sound
spectacular, thanks to its wide-angle lens and triple
mic array. The ZV-1($749.99) and ZV-1F ($499.99) are
also still available.

Image rights: Videndum Media Solutions Spa, Sony Europe BV, Native Instruments GmbH.

$109 > ww.native-instruments.coml
The Komplete Audio 1from Native Instruments is a
simple but great-sounding single-input audio
interface for microphones and other audio
sources, and it comes with a good software
bundle. We've used its big brother for years and it's
never let us down.
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Script, create, edit

alking confidently
into a micis a craft; the
more you do it, the

better you get. But that doesn't
mean you can't cheat.

If you don't feel confident
enough to ad lib, it's a good idea
to spend a bit of time scripting
what you're going to say. How
you do this very much depends

Don't film yourself with
the sun or another very
bright light source right
behind you; that turns
you into a silhouette.
And don't do the reverse
either, because you're
more likely to squint.
Plus, overly bright light will
make any imperfections
more apparent.

Many vloggers and
streamers use artificial
lights, even in daytime.
They're typically
positioned in front of and
slightly to the side of the
camera, or they're ring
lights that circle around
the camera — a popular
choice for filming on
iPhones. Your light should
be warm toned —
yellowish, not blue.

on what kind of person you are.
Some people prefer to tightly
script everything and rehearse.
If that's the case, you can use
your iPhone stopwatch to get
the timings right; and writing
apps such as our old favorite
Ulysses can give you a good
estimate of reading time too.
Pages’ Presenter Mode can turn

your iPhone or iPad into a kind
of autocue, or you could do the
simple, low-tech comedian’s
trick of scribbling keywords on
your hand.

You'll probably find that the
sweet spot for you is to script it
a little bit, but not so much that
you're simply reading. And you'll
find that the more you practice,

You don't need to go Pro = —

with Apple’s most & R
expensive apps. Whether

you want to take the

umms and aahs out of Free > www.audacityfeam.org]
your audio, resize and Audacity is a wonderful, free
resample your video, od audio editor. The software

or produce a Hollywood-
worthy production, these
free or very affordable apps
will help you organize your
audio and make your videos
even more vivid.

makes quick work of fixing
recording problems, removing
background noise and generally
making you sound fantastic. And as
it's a multi-track recorder you can
use it to record your audio too.

the more relaxed and able to go
off-script you'll become.

Of course, if you're talking
over a gaming streamorina
multiple-guest podcast, there's
no space for scripting. In these
instances, write down key
questions you want to ask or
any key points that you want to
getacross.m

$29.99

Prefer to edit your video from

the sofa or do it when you're
out and about? If so, LumaFusion is
one of the best heavyweight mobile
video editors around. It makes full
use of an iPad touchscreen and, if
you have an M-series Mac, it'll run
on Mac too.

Free
This streamer-friendly * Apple’s free movie

$9.99/month

Professional streamers use one
or more LED light to make them
look better on camera.
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sibling of Adobe’s famous
video-editing app is exceptionally
easy to use. The app is designed
specifically for online sharing, and
there's a free starter edition to give
the app a try without having to
subscribe to the full version.

making software hasn't had
a significant update for a
while. The most recent release was
last fall, but if it ain't broke, why fix
it? iMovie remains an easy and
effective way to edit video on Mac,
on iPhone and on iPad too.

Free

~, This free and open-source
‘ video editor is like an even
friendlier iMovie. It's cross-platform,
S0 you can use it on PCs as well as
Mac — handy if you're in a mixed
computer environment. It's not as
polished as some apps, but it's great
for beginners.

Image rights: Audacity, Luma Touch LLC, Elgato, Adobe, Apple Inc, OpenShot Studios LLC.
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Edit video easily

Broadcast yourself

Open QuickTime

For simple recording, you can use
a webcam on your Mac: just open
QuickTime Player and choose New
Audio Recording, New Screen Recording or
New Movie Recording. Let's go for
the Movie Recording option.

Change the camera

If you have an iPhone, its camera
is probably better than the FaceTime
camera on your MacBook or any external
USB camera. Click the dropdown next to
the red Record button and you can select
your iPhone under Camera.

See the results

Switching to your iPhone should
happen immediately, and you'll now see the
live feed from your iPhone’s main camera.
The next step is to position it: you can buy
iPhone mounts that sit on your monitor or
prop it up on your desk.

Click the red button

Clicking on the red Record button
starts recording; clicking it again stops
recording. To the left of the control panel
you'll see the elapsed time, and to the right
you can see how much SSD or disk space
you're using so far.

Combine your clips

One of the simplest ways to combine
multiple clips is to drag them onto the
timeline area one after another. You can
then adjust clip lengths, apply transitions
between clips, and add any visual effects
you might like.

Image rights: Apple Inc.

Open iMovie

When you're finished recording you
can save it or export it in a particular
resolution. The next step is to open iMovie,
create a new project and pick a theme.
This is a design for on-screen elements
such as titles.

Export for YouTube

In addition to the usual export
options, iMovie has a Share > YouTube &
Facebook option. This enables you to
output video in a social-media friendly
format, and makes sure you tag it by
getting you to fill in this screen first.

Add your clip(s)

You can import your video file(s)
either by dragging and dropping them
from your Desktop or the Finder, or by
using the Import Media button. You can
then drag individual clips to the timeline
to arrange them.

Test your video

The export process takes a while,
especially if you're using 1,280 x 720p
resolution, so this would be a good time to
take a quick break. Once your clip has
finished, test it first before uploading to the
social network of your choice.
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Become

internet
famous

aking a podcast, viog or live
stream won't magically attract
an audience. And unfortunately,

attracting an audience is where the bulk
of the work is.

There's no single trick to successfully
building your following, but there are lots of
little things you can try and everything
starts with knowing who your potential
audience is and where to find them online.
Collaborating with other creators, for
example by going on their podcasts or
having them in your videos, is a great way of
introducing yourself to new audiences. And
using your existing social media is a good

method for introducing
what you do to the people
who follow you.

Go where your target
market is — so if they're on
Reddit, be a good contributor to appropriate
Subreddits; if you're on social media,
contribute positively to trending hashtags
and topics; if you're looking for gamers, join
their Discords. Remember that blasting
people with promotional messages and links
is a turn-off for most, so if you want to grow
your audience then you need to be
interacting constructively.

If you're doing longer content, consider

clipping it: a punchy 15-second
TikTok or Facebook Reel can be
an effective way of promoting
the bigger picture of your
YouTube video or podcast, just
like trailers do for movies. Funny
is always good, but so is
surprising or helpful.
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Don't forget about your visual identity
too. There's a reason why YouTube
thumbnails for particular genres all look the
same and have incredibly similar headlines;
that particular format is what people on
YouTube are used to, and expect.

It's very hard to make money from online
media if you're not successfully reaching
large numbers of consumers, but if you are
beginning to build an ever-growing fanbase,
then there are quite a few options out there
for monetizing your content. The simplest
one is to get a cut of advertising revenues.
So for example, in YouTube, you can join the
YouTube Partner Program if you have 1,000
subscribers and 4,000 public watch hours in

Search over 260,0

Whether you're
uploading funny clips,
streaming from your
desktop or producing
podcasts, there are
plenty of places to post

and stream your content.

Many of them have lots of

handy hints, tools and tips
to help you learn the ropes
and build your brand too.
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Be creative to
connect your
world

|https://creators.instagram.comf

The original home of the influencer
has lost some of its cachet with the
rise of rivals such as TikTok, but
Insta is still the place to be for all
kinds of creatives and its Instagram
Creators section offers useful advice
on how to attract an audience.

Going viral on TikTok is the goal of
many content creators, and that
means lots of competition — but, if
you go viral on TikTok, you have a
serious hit! You'll find a dedicated
creator portal offering advice at
|tiktok.com/creators/creator-portal.|

Streaming -
Made Easy "‘

Anyone can stream on Twitch, and
you don't need a huge audience

— affiliates only need to have three
average viewers per stream in order
to unlock special features — but
you'll need 75+ per stream if you
want all the advertising options.

Image rights: Patreon, Meta, TikTok, Inc.


http://www.twitch.tv
https://creators.instagram.com
http://www.tiktok.com
https://www.tiktok.com/creators/creator-portal/en-us/
http://Amazon.com
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DO creators on Patreon

the last year (or 1,000 subs plus
10 million public Shorts views in
the last 90 days). You can then
run ads on your channel and
access other monetization
features. For game streamers,
Twitch Affiliates can integrate
ads, and you might be
approached by someone

who wants to sponsor your
channel too.

Just watch out if you're going
to be promoting other people’'s
products in your feeds; for
example, in the USA, if you
endorse a product through
social media, you need to make
it clear when you have a material

With a YouTube account, you can
create your own channels and then
upload video or live stream. The
analytics offer lots of useful info
including where viewers give up,
and if you have enough followers
you can monetize with ads.

Image rights: Google LLC, Apple Inc.

Many
podcasters
and content

connection or financial
relationship with the brand.

For many online
broadcasters, the money comes
from additional extras rather
than ads; many podcasters sell
merchandise, use Patreon
to offer paid subscriptions
that deliver extra episodes
and other exclusive subscriber-
only content, and might even
sell tickets to their own tours
and events. Just be careful: if
you'e too aggressive in trying to
monetize your broadcasting,
you could end up driving some
of your hard-won listeners or
viewers away. m

|podcastsconnect.apple.com|
Apple Podcasts Connect is an
iCloud-style dashboard that makes
it easy for you to upload podcasts
and see how well they perform, with
graphs to show wha's listening, what
they're listening to and where they're
coming from.

Q&A: Chris Phin,"
creative director |

Former Apple editor Chris
Phin now works as a
creative director

in podcasting, where he
presents, produces and
advises others on how

to broadcast better.

ML>

With very few exceptions,
everybody feels like a
chump whenrecording,
and hates how they look
and sound when they're
editing or reviewing. Be
kind to yourself. | promise
thatyou'llgetused toit,
and | promise the result
isn't as bad as you fear —
both because, well, first,
itjustisn't! There's literally
nobody outside your head
who's a harsher critic. But
also because unless you're
working live, you can do it
again and again, or tweak
takes, until you merely
hate the clip, rather than
hating yourself!

ML>

Bad audio is more tiring to
consume than lackluster
video. Get your mic right.
Though there are
exceptions, adynamic mic
with a cardioid pickup
pattern, such as the entry-
level Samson Q2U (about
$70.[samsontech.com), is

agood choice — butlearn

Broadcast yourself

w

Chris Phin has moved from
publishing to podcasting.

how to useit. It should be a
fist width from your mouth
and angled away at 45°.

ML>

The sooner you can take
the plunge into more
advanced apps (say, Logic
vs Audition — though
actually GarageBand is
great); processes (for
example, recording each
voice on to its own track);
and platforms (say,
rather than
Zoom), the quicker you'll
realize pros don't use them
just because pros like
being fancy. They are
daunting, but as well as
usually being capable of
better results, they are
ultimately faster and,
counter-intuitively, easier
too. The learning curve is
steep though.

ML>

Script the intro, script
the outro, and wing it
abitin the middle!
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'CLEANUP

YOUR HARD DRIVE ~

Whether you're rapidly running out of space or simply
want to put your files and apps in better order, the answer
lies with a cleanup of your Mac's storage

OWEVER MUCH STORAGE you
H have on your Mac, you'll always

find a way to fill it. You might
vow every time you buy a new model to
keep it running swift and smooth, but
over time your best intentions get
overwhelmed, whether that's down to a
lack of time or falling into bad habits.

Even if your Mac's storage is

still relatively empty, you'll have
noticed it start to fill up. Perhaps you've

WRITTEN BY NICK PEERS

£ conen

Scanning for clutter...

8 found so far

cance,
%

taken a brief tour of your personal
user folders and realized there's junk
on there that needs clearing out.

Or maybe you're just desperate to find
anew home for files you no longer
need on a daily basis but might want
access to later.

Whatever your motivations for
clearing out your Mac's storage drive,
we're here to show you everything you
need to know, from easily identifying

those files that you no longer need, to
ensuring redundant apps get
thoroughly removed when you're done
with them. Over the next few pages
you'll discover the best tools to comb
through your system, and learn
how to move your largest files without
disturbing your current setup.

So without any further ado, let’s get
out our virtual dustpan and brush and
start cleaning up! =
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Clear out junk quickly

Let's begin by identifying and removing those files you no longer need

EFORE YOU CAN start to clear the
B clutter off your Mac, you need an

overview. Open System Settings
and navigate to General > About, then
click Storage Settings. At the top, you'll
see a color-coded chart representing

your internal storage and how the space
on it has been used up; this will be

System Settings does a good job of
revealing the largest files and apps on
your system, but if you want a more
visual overview of your storage drive's
layout then you need a tree map. This
provides you with the ability to identify
not just large files on your drive, but

discover where they're hiding in your
file system, speeding up the clearout
process. If you find the tree map
provided by Grand Perspective (right)
a little confusing to follow, you could
try DaisyDisk ($9.99, https://
daisydiskapp.com) instead, which
uses a sunburst map to help you
navigate to large files on your drive.

represented in categories such as
Documents, Apps, and System Data.
Beneath this chart, you'll see these
and other categories (iCloud Drive, Mail,
Messages and Other Users), all displayed
with the actual amount of space they're
taking up shown in gigabytes (GB) or
megabytes (MB). Next to most of these

What happens if you accidentally
delete the wrong file — one that might
contain a precious, irretrievable
memory if lost forever? The answer
lies in making sure your Mac is backed
up. The simplest way to do this is
through Time Machine (System
Settings > General > Time Machine).
By default, it's set to back up every
hour, so should have you covered.
Should you need to recover any
accidentally deleted files, open your
Time Machine backup drive, click
“Enter Time Machine Backup’, then
browse to the folder containing the file
you deleted to retrieve it. g

HOW TO Clean up your hard drive with CCleaner

is an “i” button; click this and a new
window will open enabling you to view
the selected category in more detail,
such as a list of applications with the
largest apps displayed first. Documents
gives you a choice of four views: Large
Files, Downloads, Unsupported Apps
and File Browser.

There's one automated cleanup
function built into macQOS, and that's
the ability to prevent the Trash from
filling up over time. Open Finder, then
select the Finder > Settings >
Advanced tab and tick “Remove items
from the Trash after 30 days". If you
want to automate any other folder
cleaning, however, you'll have to
investigate Hazel for $42 (14-day trial,
www.noodlesoft.com). This makes it
easy to build a script that will — for
example — enable you to
automatically move files that have
been in the Downloads folder for more
than four weeks into the Trash.

<

| Scanning for clutter...

/l Quickly remove clutter
Open CCleaner (WWw.ccleaner.com)
after installation and click the Scan button
next to “Clean clutter”, giving access to any
drives CCleaner requests. You'll see a
progress bar appear revealing how

much potential trash has been found.
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We've found 4.8 TE of clutter

Review and remove
You'll be shown a summary of
what's been found, with certain sections
automatically ticked for removal. Click one
to review the details of what's been found
(and untick individual items). Click Clean

to remove your selected files.

Here's what you can clean

20,225 ihema selacted {1.07 G8) “

3 Clean up your browser
Over time, your web browser can
accumulate quite a lot of junk. Click Scan
under Clean Browser to see how much you
might save. You can go with CCleaner's
recommended selection, or click Details

to pick and choose what to remove.


https://www.ccleaner.com
https://daisydiskapp.com
https://daisydiskapp.com
https://www.noodlesoft.com

System Settings can help you quickly reclaim
lost space by revealing the files taking up most
space on your system.

From here, you can identify the
largest files on your system and clear
them off to free up space if you're
running low. Note that when you click
Delete, you'll be warned that the files
will be immediately removed — they
won’'t end up in the Trash as a fail-safe.

Although a good start, this merely
scratches the surface; in order to
perform a much more thorough clean
of your system, we recommend looking
at the list to the right here, which
reveals five free cleanup tools that can
do a better job than System Settings.
Then follow the step-by-step guide
below to discover how to use the free
version of CCleaner to perform a deep

Top b5
Free
cleaning
tools

The following collection of
tools are designed to help
you with your clearup —
they're all free to use and will
enable you to reclaim even
more space from your
overburdened Mac storage
through a variety of
techniques.

AppCleaner
https://bit.ly/3gEEhNN
While you can thoroughly clean
apps in CCleaner, AppCleaner lets
you see exactly what files it's
found when scanning for program
leftovers. If you want complete
control over app removal, this is

GrandPerspective
shttps://bit.ly/3sjkukV]|

Let GrandPerspective scan your
system drive for a handy visual
tree map of your Mac's storage,
with your files represented
relative to their size and location.
Roll your mouse over one for its
name and file path.

Maintenance
http://bit.ly/3P82Bru
Maintenance is a cut-down
version of the Onyx system tool.
Its more user-friendly and
offers four tools: System,
Applications, Internet and Other.
Click the “i” next to each one to

Clean up your hard drive - }

L

Monolingual
https://bit.ly/3QK3Luw
Monolingual makes it easy to
reclaim hundreds of MBs of space
by removing unused languages

— your default language isn't
selected, so review the list and
click Remove. Read the warning
and click Continue to finish.

CCleaner

>WWw.CcCleaner.com

As general-purpose cleaning
tools go, CCleaner has plenty
going for it, not least the fact

its key functionality is free. The
step-by-step guide below reveals
how it can help quickly clear lots

clean of your Mac. » the tool to choose. decide what to clean. of clutter from your Mac.
. 1 e [
| You have 30 startup items | You have 3 apps Are you sure you want to uninstall
1 ] these applications?

4 Weed out startup items

Click Show under “Manage startup
items” to reveal what programs and
processes are set to start with your Mac.
Reclaim memory and speed up login by
flicking the switch next to unused or
unwanted items to Off.

5 Uninstall apps

@ Flexamg

@ PartableAppabachielper
o Shack

° Vi

® MacFamiyTree 3
O Flex Mt S

m

pre—

é Complete removal

Click Show next to Uninstall Apps for
a quick and easy way to remove unwanted
apps from your Mac. You can view three
lists: All apps, Unused apps (those not
opened in six months or more), and Large
apps. Tick those apps you want gone.

Image credits: Apple Inc, Erwin Bonsma, Ingmar Stein, FreeMacSoft, Titanium Software, Piriform Software Ltd.

Like AppCleaner, CCleaner
doesn’t simply remove the app from
the Applications folder, but it also hunts
down leftover files such as library items,
plug-ins, preferences, and more to ensure
more traces of the programs are gone.
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If space remains tight, find out how to restore — and increase — capacity

H H FTER YOURFIRST cl : ‘Il
Find visually Al YRR
e o . able to use the tools we've covered so
similar plctu res far to keep your system in check, but -

over time you'll find the space being regained
lessens even as your drive capacity
continues to shrink. So what else can you

| do to ensure you're not left facing dreaded

“disk full” messages?

One major cause of wasted storage space is
duplicate files. Don't confuse these with
backups; they're simply redundant copies of
files and may be spread across multiple folders
or even storage drives. Duplicates don't have to
be identical either — how many times have you
taken multiple photos with the aim of keeping
only the best shot, only to leave them all piling
up, slowly eating away at your storage space?

There are two free tools we recommend for
this task. The first is our old friend CCleaner

Duplicates

1L

i

dupeGuru can help you remove
close variants of a photo.

_

=

Duplicate files can be responsible for a lot of wasted
space on your Mac — so weed them out.

Expand your storage

If your Mac has limited storage
capacity, one long-term solutionis
to upgrade it. Since the internal
storage in most Macs these daysis

fastest drive you can afford to
maximize performance. This means
pairing a NVMe drive with a
Thunderbolt 3/4 enclosure that can
deliver speeds to rival your Mac's
internal drive — around 2,000-
3,000MB/sec.

You can expect to pay around
$180 (500GB) to $210 (1TB) for a

fixed at the time of purchase, that
may not be an option.

The solution lies in purchasing a
new external drive, but rather than go
for the biggest capacity, look for the
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When you're looking through duplicate items in Music,
be sure to check for different versions of the same song.

(see[p.62) and its “Find duplicates” tool, which
scans files by their contents as opposed to
merely comparing filenames to identify exact
duplicates. By default, your home folder is
selected for scanning — if you're simply looking
for possible duplicates within your Mac's storage
drive, simply click Scan to see what it finds.
Alternatively, you can widen your search to
include other drives and folders by clicking Add,
remembering to exclude any folders containing
actual backups.

The initial scan can take some time to
complete — particularly if you're scanning
non-solid-state drives — so be prepared to
leave CCleaner for an hour or two to complete
the scan. Once it's complete, a summary of how
much file space is taken up by potential
duplicates will be shown — you can click View

Samsung 980 Pro NVMe drive (www.
samsung.com) and Anyoyo enclosure
(www.amazon.com). If you can

make do with slower speeds (around
1,000MB/sec — still quicker than a
SATA SSD), you can pair the Crucial
P3 1TB drive [www.crucial.com) with
a Ugreen USB-C enclosure (www.
ugreen.com) for under $80.



http://www.samsung.com
https://amzn.to/3lgFDSD
http://www.crucial.com
http://www.ugreen.com
https://dupeguru.voltaicideas.net
http://www.samsung.com
http://www.ugreen.com

Find slimmer apps

Obviously removing apps is one way to
quickly free up space, but you don't
necessarily have to give up functionality
to do so. For example, do you really need
Adobe Reader (517MB when installed)
when you can view PDFs in Preview or
your web browser? Also look to see if you
can source slimmer versions of the apps
you currently use — for example, if you
want a dedicated PDF viewing app. then
Skim {https://skim-app.sourceforge.io)
takes up just 29MB of space. Visit

(https://alternativeto.net)) to track down

more alternative apps.

Don't burden your Mac with bloated apps —
Skim takes up just 5% of the space
Adobe Reader demands.

Duplicates to see them all side by

side, or use the categories on the

left to filter by specific file types.

Use the “Sort by” button to

change the sort order (choose Size to
zero in on those duplicates taking up
most space, for example). Double-click
an item to open its path in Finder,
enabling you to compare each duplicate
to determine which one to keep.

You can also manually comb through
the list, selecting which duplicate you
want to keep or click the “Nothing
selected” drop—-down menu to choose
“Keep oldest” or “"Keep newest” to make a
quick selection. Once you're happy with
your choice, click Clean. Again, there's no
fail-safe move to the Trash before files
are removed, so make sure to proceed
with caution.

CLEAN UP MUSIC AND PHOTOS
One way to remove visually similar photos
is to use dupeGuru as outlined opposite,

Move
large files

Still running out of
storage space despite your
cleanup efforts? Attach a
USB SSD or NVMe drive to
double or even treble your
drive capacity, then
discover how to move
items across without
disrupting your experience.

Copy file/folder

Locate your first large file or folder
on your main storage drive, then
copy it across to the relevant
folder on your secondary drive.
Once it's been copied across, you
can delete the original on your
main drive to free up space.

Prep newdrive

If you're connecting a new drive for
the first time, open Applications >
Utilities > Disk Utility. Select the
drive; assuming it's not already
APFS-formatted, click Erase, make
sure APFS/GUID Partition Map is
selected, and click Erase again.

Create aliases

Once copied, Ctrl-click the file or
folder and choose “Make Alias” to
create a shortcut. Move this back
to its original location for easy
access — the alias will always
know where to find the original,
even if you move it again.

"

Setup folders
Browse to your new drive and
set up a simple folder structure
that mirrors your user folder on
your system drive; so, a parent
[Your name] folder, inside which
are separate sub-folders for
Pictures, Documents and so on.

Update backup
Once you've freed up space on your
main drive, open Time Machine via
System Settings > General. Click
Options and check to see if your
new drive is in the excluded list — if
itis, select it and click "-"

followed by Done. “

but if you're already managing your
photos using Apple’'s Photos app. then
you'll find tools for managing duplicate
photos in there too — particularly for
those photos synced to your Mac from
your phone via iCloud.

Simply open Photos and select
Duplicates for a list of all images that
match Photos’ definition of a duplicate:
visually identical, but not necessarily
having the same metadata, formats
or resolutions. You can then “merge”
these individually, or press Cmd+A to
select them all and click “Merge [xxx]
items” in one go.

Photos will pop up a fail-safe dialog
giving you the option of merging only
exact copies of files, or you can go ahead
and merge all items. Whichever option
you choose, the redundant files will be

O

placed in the password-protected
Recently Deleted folder from where
you can recover any you've mistakenly
removed or delete them now, rather
than wait for Photos to delete them
automatically after around 30 days.

You can also rationalize your music
collection in a similar way — open Music
and choose File > Library > Show
Duplicate Items. You'll get a list of all
items that share the same title and artist,
but be careful to properly scrutinize each
one, particularly the track’s length and
album — you could find that different
versions of the same song are marked
as duplicates. Ctrl-click an item and
choose Get Info for a detailed view,
then choose “Delete from Library”
followed by “Delete Song” for any
tracks that you're happy to lose. =
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A very flexible display with
plenty of nifty features;
rotate the monitor 90
degrees for a portrait view.

THE BOTTOM LINE

The Dell U3224KB’s 6K
screen can go toe to
toe against Apple's
Studio Display and win.
However, its high price
and so-so sound

quality count against it.

Big, beautiful 6K display
Flexible stand

2 Eye-wateringly expensive

B Soundbar audio is poor
GOOD mmmu
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Dell UltraSharp U3224KB

An amazing 6K display —

$2,559.99 From|www.dell.com/en-us]|

but a hefty price tag

Features 31.5-inch LED backlit IPS LCD display, 6K (6,144x3,456 pixels) resolution, 5ms response
time, 450cd/m2 brightness, DCI-P3 color (99%), integrated 4K webcam (3,840x2,160 pixels) with
5x digital zoom, 2x array microphones, 2x 14w speakers, height-adjustable stand

WHETHER YOU'RE LOOKING for a best-in-
class monitor for work or for home, the Dell
UltraSharp U3224KB is a great place to start.
The price, though, will make you wince; it's over
a $1,000 more than Apple's Studio Display —
and that was hardly cheap to begin with.

Let's start with its design: the monitor itself
is clad in silver and pale gray plastic with thick
black bezels around its 31.5-inch 6K screen.
The bezel is particularly thick at the top, where
the soundbar and the webcam reside. The
soundbar itself is covered In black fabric, while
the webcam is adjustable, tilting forwards and
backwards, enabling you to frame yourself
perfectly when making video calls, no matter
how high or low the monitor sits on the
supplied stand. With the thickest bezel at the
top comprising the soundbar and camera, the
second biggest bezel is at the bottom. There's
a reason for that too. Wave a hand over the
bottom left of the display and its five touch-
sensitive webcam buttons light up: Hookswitch
(to answer or reject an incoming video call),
Volume Down, Volume Up, Microphone Mute
and Camera Mute. Also secreted in the bottom
bezel is a pop-out containing the display’s
front-mounted Quick Access ports — 2x
USB-C and 1x USB-A for connecting and
charging devices such as an iPhone.

BUILT-IN FUNCTIONALITY
The generous port selection continues around
the slightly curved back of the U3224KB where
you'll discover a Thunderbolt/USB 4 port with
140W of power delivery (PD), enough for the
latest 16-inch MacBook Pro, a second
Thunderbolt/USB 4 port, three USB-C ports
and four USB-A 3.2 ports. Alongside them,
you'll also find an HDMI port and a DisplayPort
2. (which both support the HDCP 2.2), plus an
Ethernet port. Having all those ports to hand
turns the U3224KB into a desktop hub as well
as a monitor, making it easy to hook up your
Mac to all kinds of peripherals.

Where the standard Apple Studio Display
limits you to just tilt adjustment, the stand
supplied with the U3224KB goes all in. Made

from metal and plastic rather than aluminum, it
has a hefty base to keep the monitor firmly
planted on your desk and also offer both 26
degrees of tilt adjustment, and 60 degrees of
swivel adjustment to make sitting in front of it
suitably comfortable. But the biggest boon is
the built-in height adjustment, which enables
you to raise or lower the monitor by up to 6.3in.
Push it gently up to its maximum height and
you'll discover another bonus: the U3224KB
display can also rotate by up to 90 degrees,
enabling you to view documents and other
content in portrait as well as landscape, even if
you have to tilt the monitor back on its axis to
enable it to perform a full landscape-to-
portrait sweep. Having that flexibility right out
of the box is great, but the bigger question is:
does the Dell U3224KB's picture and sound
quality justify its steep asking price? The
answer is a qualified yes.

The Dell U3224KB's big, beautiful display is a
delight to behold, delivering a high level of
color accuracy and deep contrast whatever
kind of content you throw at it. Fire up a 4K
HDR movie from iTunes and you'll be truly
immersed in the events unfurling on-screen,
while gaming looks great too — we rarely
experienced any issues with lag, thanks to the
monitor's 5ms response time. When web-
surfing and document editing, everything looks
pin-sharp with even tiny text remaining legible,
even if at 450cd/m2 the Dell U3224KB can't
match the Apple Studio Display’s 600 nits
brightness. Creative pros will be disappointed
too by the lack of Adobe RGB support, but for
general productivity and home use, the
U3224KB looks great.

Indeed the only slight letdown is the sound
quality. Having the soundbar perched on top
rather than below the display has resulted in
somewhat thin-sounding speakers that are
passable when used with the 4K webcam and
for interface effects, but soon becomes
wearing when streaming video content or even
music — the Apple Studio Display’s downward-
firing speakers sound much better.

ROB MEAD-GREEN
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THE BIG, BEAUTIFUL DISPLAY
IS ADELIGHT TO BEHOLD,
DELIVERING A HIGH LEVEL
OF COLOR ACCURACY
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Designed for travelers, the
Tour Pro 2 provides good
battery life and an ingenious
charging case.

THE BOTTOM LINE

A little pricey, but
good sound quality
and battery life make
the Tour Pro 2 a great
option for people who
travel a lot.

Good sound

Impressive battery life

Innovative charging case

B Average noise
cancellation

GREATHREN
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JBL Tour Pro 2

|deal for traveling, with an innovative charging case

$249.95 From[hifps:Zjbl.com

Features Bluetooth 5.3, AAC; 10 hours battery (8 hours with noise cancellation); charging case with
1.45" touch display; True Adaptive Noise Canceling; Find My Buds feature

AT FIRST GLANCE, JBL’s Tour Pro 2 earbuds look
like just another AirPods clone. However, a
quick look at the ingenious design of the
charging case tells you that JBL has brought
some of its own ideas to the table too.

Available in black or silver, the little
earbuds are light and comfortable to wear, but
they’re rated IPX5 for water resistance, so
they’re tough enough for outdoor use or
exercise. They also provide impressive battery
life, lasting for ten hours on a single charge, or
eight hours when using noise cancellation. The
case also lets you recharge the earbuds three
more times, so you don’t have to worry about
the battery dying on a long journey.

In fact, the charging case turns out to be the
star of the show, with a high-tech design that
even Apple can’t match. The case has a 1.45—
inch touch-sensitive screen on the front,
which you can activate by swiping your finger
to the right, and then swipe again to view a
series of additional controls. This allows you
to quickly adjust all the main settings without

having to take your iPhone out of your pocket,
or turn on your iPad to use the JBL app.

But, of course, none of those features would
matter if the sound quality didn’t meet
expectations. The Tour Pro 2 delivers the
goods, though, supporting Apple’s AAC codec
and providing a taut, sinuous sound for the
electronic bass on Prime Evil by The Orb. The
bass isn’t overwhelming though, and the Tour
Pro 2 also picks out the sharp ticking of the
percussion that gives the track its nervous,
manic energy. It can handle delicate classical
sounds too, with a light, wistful tone on the
melancholy piano and violin duet on Arvo
Part’s Spiegel im Spiegel.

The noise cancellation features aren’t quite
as noise-crushingly effective as Apple’s
AirPods Pro, but they should still help you to
relax on a noisy train or plane, and there’s
even a “silent” mode that turns off the music
but leaves noise cancellation on for a set
amount of time so that you can have a nice
quiet nap. CLIFF JOSEPH

Image rights: Harman International Industries, Incorporated.
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Firmament

Tough testing, trusted ratings

We're solving puzzles... but why?

$34.99 From[hifps:/cyan.com

Needs macO0S 13.3 or later

FIRMAMENT IS THE latest puzzle
game from Cyan Worlds, the

# creators of Myst and Obduction.

- It’s got plenty to offer, but lacks
some of the magic that infused the
company’s previous attempts. What it does
not lack is beauty though, and it’s full of
gorgeous environments. The landscapes
rise and fall and are dotted with ladders and
elevators, providing ample breathtaking
vistas to the grateful gamer.

The world is comprised of a series of
long-abandoned realms, where all that
remains are enormous steampunk
structures that guard the lands and help
traverse them. The eerily empty worlds are
punctuated by an atmospheric score that
swells at just the right moments, making
itself known when you discover a strange
device or solve a challenging brainteaser.

NOT QUITE PUZZLE PERFECTION
Puzzles in Firmament are a mixed bag. Some
are straightforward, while others had us
scrambling for a walkthrough, and there
were occasions when our bafflement ticked
over into frustration. Some puzzles
appeared to stall or become stuck for no
reason, and the game could do with a touch
more visual exposition at times.

Your ticket to solving the puzzles is the
Adjunct gauntlet. Hold the left mouse

Some of the game’s puzzles can be baffling, and as there
are no hints, you're on your own.

Image rights: Cyan Worlds.

button to fire a beam into sockets and
activate nearby structures, such as opening
a locked door or raising an elevator.
Unfortunately, this feels rather clunky, and
at times the Adjunct will refuse to connect
when you’re sure you’re within range.

LIGHT ON LORE

The game’s biggest problem, though, lies in
its lore. A mysterious ghost explains that
you are a Keeper and that you must use the
Adjunct to protect the Realms on the
Firmament. What all that actually means,
though, is unclear for much too long. You
find yourself wandering the beautiful
Realms solving puzzles without the
foggiest clue why you’re doing it. Add that
vagueness to the human-free worlds and
dearth of interactive environmental objects
and you can’t help but sense that
something is missing.

Ultimately, Firmament’s striking world
feels a little bare. At its core is the same
puzzle-filled heart you’ll find in other Cyan
games, but the body that surrounds it is
strangely hollow. ALEX BLAKE

Firmament's beautiful
steampunk setting is
a visual pleasure.

THE BOTTOM LINE

A reasonable
puzzler that doesn't
live up to Cyan's
previous efforts.

Gorgeous environments

Some challenging
puzzles

Excellent music
2 Clunky Adjunct
GOOD mmmn
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Anker 548 Power Bank

Portable power for your smaller devices

$169.99 From[www.anker.coml|

Features 2x USB-C, 2x USB-A, 60,000mAh capacity, built-in light, solar input option

STRIKING A GOOD balance between capacity
and portability, Anker’s 548 Power Bank is
designed for recharging your devices on the
move. It has a convenient carrying handle,
though oddly for a product that makes
mention of camping, no specific water
resistance rating. It charges over USB-C and a
cable is supplied. The internal LiFePO4
EV-grade batteries have a capacity of 60,000
mAh; 192Wh. Anker says that’s enough for 2.9
full charges of a MacBook Air, 3.2 of an iPad
Pro, or 7.4 of an iPhone 14 Pro Max. They’re
also rated for 3,000 charge cycles, which
should ensure longevity.

There are two USB-C ports on the front
panel, one of which accepts input for charging
the bank and allows 60W output to a laptop.
The other is output-only and provides 27W of
power, which is plenty for smaller devices like
iPads. The 60W port will be slower to charge
16-inch MacBook Pros, and you won’t be able
to take advantage of the features of some of
the latest MacBook models which support
140W charging and fast charging. That said,
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the 548 isn’t billed as a super-powered
charger but as one that’s portable, so
this is an acceptable trade—off. You also
get two USB-A ports for charging
smaller devices and the bank has an
input for a solar panel, making it handy
for when you go off-grid.

An unusual feature is the built-in LED
light that you can extend from the top of
the unit and then use on one of two
brightness settings for up to 42 hours. It
can also function as an emergency light
— plugged into the wall and in auto
mode, it will activate if it detects a
power outage. Pressing the SOS button

will cause it to flash a distress signal too,

if you’re really stuck. Of these it feels
likely that a standard camping light will
be the mode most people use, but it’s a
nice addition.

This is a well-built and very portable
power bank with a solid capacity, great
for charging the kinds of devices you
might take on a trip. HOLLIN JONES

Recharge the power
bank from a wall outlet
or via an optional solar
charger attachment.

THE BOTTOM LINE

A great portable
charger for keeping
your smaller devices
powered while

on the road.

Solid, portable design
Great for smaller devices

Light is a nice addition

2 Drained fast by laptops
GREAT EmE®
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Tough testing, trusted ratings

® ® T.hough it's not obvious at

Twelve South HiRise Pro st s el
harger for iPhone charging.
Neat, but expensive adjustable MacBook stand .

$99.99 From

Features 2.5 to 6 inches of height adjustability, MagSafe housing in the base, 1.65 Ibs, suitable
for MacBook Air 11-inch (2015) up to MacBook Pro 16-inch (2023)

THERE ARE PLENTY of MacBook stands out before. What is completely new, and
there to choose from, so what makes Twelve very modern, however, is the MagSafe-
South’s latest HiRise Pro worth looking at? For ~ ready base, which allows you to fast—
starters it’s very high quality, with an overall charge your iPhone using the wireless
metal design that matches the MacBook MagSafe standard by placing it on the
aluminum aesthetic perfectly, with a vegan base of the unit. There’s no MagSafe
leather trim on the base of the unit, which charger included, so you’ll have to bring
feels soft and looks great. your own, but the provision to add it can
It’s also height adjustable — in its default be found underneath the base.
form, with the piston-style arm recessed As to the area at the top for mounting
inside the stand, it measures 2.5 inches, but your MacBook, the V-shape design JHE BOTTOM LINE
can be raised to 6 inches to make it suitable for = neatly matches the Twelve South logo, Easy to adjust height,
those with a higher seating position. The and offers a secure fit for your machine and it looks great.
adjustment is completed via a screw on the thanks to the textured rubber material, :r? Uit [FEV IR Gt 7als
3 e MagSafe charging
rear of the base which when unscrewed allows and the curve at the bottom of each end pad though.
the arm to retract — when you reach the of the stand, to prevent your MacBook
desired level of adjustment, just tighten the from falling off. Height adjustable
screw. We did find at the highest point of Overall, the HiRise Pro is a great Secure
adjustment that the stand felt slightly wobbly,  stand, aside from the minor wobble at
but lowered just ever so slightly seemed to the top of its extension. The MagSafe LB
eliminate this issue. charging pad is a neat feature, though B Cheaper alternatives
Admittedly, this style of height adjustment  you may not benefit from it unless you without charging pad
is nothing new; we’ve seen it on older stands have a new iPhone. NICK ODANTZIS GREAT ENEE
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@ Reviews

Logic Pro for iPad

Pro-level music tools come to iPad
Free for 1 month; $4.99/month; $49/year From[www.apple.com|

Needs iPadOS 16.4 or later and a device with A12 Bionic chip or later

APPLE HAS BEEN
trying to convince us
for a number of years
that an iPad can
replace a Mac for professional
creative work, and in a handful
of cases like art and graphics
that’s arguably been true. For
music production however,
serious Digital Audio
Workstations (DAWSs) haven’t
made the leap to iPad, with the
notable exception of Steinberg’s
Cubasis. Perhaps in an effort to
remedy this, Apple has created
Logic Pro for iPad. Light years
more powerful than
GarageBand, it’s also not a
direct port of Logic Pro for Mac.
Instead, Apple has created a
supremely powerful app that
will be familiar to existing users

dynamic mix.
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Professional produ

Automate volume
Rarely found in iPad apps, Logic
lets you use your finger or an Apple
Pencil to enter automation curves
to change volume, panning, filters
and many other parameters over
time for a more interesting and

but is completely reworked '-\_(
for the touch interface.

AT YOUR FINGERTIPS

Unlike Final Cut Pro for iPad
with its exacting graphics
requirements, Logic Pro works
on any iPad with an A12 Bionic
processor or better, which
includes all recent models. This
combined with its one-month
free trial means a great many
people will be able to try it out
for themselves. While the app is
around 700MB a full install of
all its loops and content weighs
more like 15GB, which combined
with space for recordings could
be an issue for iPads with lower
capacities. It was tested on an
Mi-powered model and an A12
model and while performance

Play your way
There are multiple touch-based
ways to play including a keyboard,
drum pads and chord pads. These
can be further configured to
behave in the way you want, adding
real-time controls like sustain. Or,
connect a hardware controller.

[/ Mac|Life \

EDITOR'S
\\ CHOICE

Use your iPad's mic and speakers or connect an audio interface.

on the M1 was buttery smooth, it was slower but
still acceptable on the older model.

This is a remarkably accomplished music
production suite and one that perhaps only Apple
with its vast resources could have pulled off. As

ction on a touch screen

Export for mixing
While you can mix on the iPad it's
also possible to move to Logic on

Mac, or export each track

separately to mix on a different

system entirely. This gives you
plenty of options for
finishing a project.


http://www.apple.com
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such it’s possibly a little
daunting for newcomers, but a
number of excellent tutorials
and walkthroughs are provided
to get you up and running. There
are several track types available:
MIDI and pattern-based
software instruments, audio and
drummer tracks. The content
library lets you preview patches,
loops and samples and drag and
drop these into your project. For
each track type, advanced,
desktop-class editing tools are
available and these extend to
beat stretching audio,
generating MIDI patterns, and
much more. Plus, extensive
Apple Pencil support makes
tasks like drawing automation
curves a breeze.

BUILT FOR PROS
Many of Logic’s classic software
instruments and effects plug—
ins have been carried over and
are available to load into
projects. Audio Unit plug-ins
for iOS are supported but these
are not nearly as commonplace
as they are on the desktop. So
while you can transfer projects
between iPad and Mac via
iCloud or the share sheet, any
Mac plug-ins will need to be
bounced down to audio before
they can go over to the iPad.
Hopefully the release of this
app will encourage developers
to up their game when it comes
to iOS audio plug-ins.

Logic’s design is superb,
doing away with windows in

The app’s interface
lets you show and
hide multiple
elements easily.

Below left: A good
selection of
instruments and
effects is included.

Below right: The
touch interface is
especially good for
working with loops
and MIDI.

favor of a highly customizable
interface that encompasses
plug-in chains, a powerful
mixer, arranger section, audio
and MIDI editors, and much
more. You really can record,
program, edit and mix whole
projects in it, to a highly
professional standard. You’ll
want to add an iOS—compatible
audio interface for proper
recording and monitoring and
maybe a MIDI keyboard too, but
the same is true of a laptop.

TABLET-BASED MUSIC MAKING
This is by some distance the
most powerful and well—-
designed music app for iPad
ever made. There’s the odd
complaint — iPadOS still limits
you in a way macOS doesn’t —
and beginners will take a little
time to come up to speed. The
subscription model will have its
detractors too, and it doesn’t
feel like something a company
as rich as Apple really needed to
do. But Logic Pro for iPad really
does justify the “pro” label, a
slick and powerful app that will
complement or even for some
users replace the desktop
version. HOLLIN JONES

THE BOTTOM LINE

A hugely accomplished music
production app for iPad that
deserves the Pro label.

Very powerful tools
Superh touch-centric design
Excellent content included

B Subscription model
AWESOME mmmEN
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The microphone comes
with a clip-on pop shield
to help capture
glitch-free recordings.

THE BOTTOM LINE

A high-quality and
sensibly priced
microphone for voice
recording that just
works, with a
minimum of setup.

Excellent audio results
Great build quality

Auto gain control

Stand and pop shield
AWESOME Emmmm
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Ma

EDITOR'S
CHOICE

AT2020USB-XP

High—quality voice recording for content creators

$169 From[www.audio-technica.com

Features USB-C power, up to 192kHz operation, pop shield, latency-free monitoring, capacitive mute

button, USB-C cable and a USB-A adapter included

AUDIO-TECHNICA HAS updated its AT2020 USB
microphone family with a new model that adds
very high—quality recording options with up to
24-bit, 192kHz sample rate possible via its
new analog to digital converters. When
plugged in to your Mac or USB-C iPad it
appears as both an audio input and output
device, with a 3.5mm headphone jack on the
body letting you monitor both your own voice
and audio streamed back from your Mac. This
has a high-output amplifier that is able to
provide plenty of volume so you won’t struggle
to hear yourself back.

Direct, latency—free monitoring is supported
and as well as a headphone level control, you
get a mix control to adjust the amount of
computer audio fed back into the headphones.
There’s a desk stand in the box and also a
thread adapter, and a clip—on pop filter helps
to prevent plosives affecting your recordings.
While some microphones feature internal pop
shields, an external one is generally held to be
more effective since it puts a bit more distance

between the shield and the capsule, making it
more resilient in stopping blasts of air.

Aimed at podcasters, streamers and other
content creators, the mic uses a cardioid
condenser pickup to detect sound from the
front so it’s ideal for use by a single presenter.
While maintaining a consistent volume level
can sometimes be tricky as you naturally move
back and forth a little while speaking, this
model has an optional automatic gain switch
that does an excellent job of dynamically
altering levels to keep the signal consistent.

The recording results are excellent,
capturing a strong and clear signal with
negligible noise even at high gain levels. We
did find the automatic gain feature particularly
useful as it meant one less thing to worry
about, keeping the level consistent even as we
moved around a little.

If you are making podcasts, streaming or
recording voiceover, the AT2020USB-XP is a
high quality, affordable and hassle-free way to
get great results. HOLLIN JONES

Image rights: Audio-Technica.
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Mimestream

Elevate your Gmail inbox

$49.99/year From[hifps:/mimestream.com]

Needs macOS 12 or later

Tough testing, trusted ratings

CHOOSING AN EMAIL client can
be tough, but Mimestream may
be just what you’re looking for.
There’s the large caveat that it
only supports Gmail accounts, but if you
don’t use iCloud, Hotmail or anything else,
it’s one of the best email clients around.
Mimestream feels like something Apple
could have cooked up, and integrates with a
host of core macOS features, including Dark
Mode, swipe gestures and keyboard
shortcuts. Its layout is simple, familiar, and
easy to digest, being neither overcrowded
nor overly sparse. But if it doesn’t suit you,
there are four different layout styles to
choose from.
You can add multiple Gmail accounts
and house them in a unified inbox or
separate them into their own tabs. We set
one as a personal account and one as a work
account, but you can set them up however
you like (and add more than two). Each can
have its own color and icon, making the
distinction clear. This tabbed approach is a
great way to filter out distractions.

CLEVER FEATURES

There are neat touches everywhere. Email
threads can be expanded or contracted at
the click of a button. Highlighting text and
clicking reply lets you quote that text
directly. There’s also a button to filter your

A menu bar icon displays your unread message count.
Click it and you'll see the five most recent unread emails.

GUE - D= o

Image rights: Mimestream

inbox by your chosen combination of
unread, starred and important mail.

Dive into the settings and there’s more
to find. There are email signatures (which
can be different for new messages and
replies), templates, default font options
and granular undo send timers. It’s highly
customizable, although not infinitely so.

We particularly liked the notification
schedule. This lets you block alerts for each
account at times you define, so you can
disable notifications from your personal
inbox during work hours.

Mimestream plays things pretty safe,
and there are no radical new concepts here,
just a highly competent email app that
serves Gmail users very well indeed. And
really, that’s probably one of its strongest
aspects. There’s no learning curve at all and
everything is exactly where you expect it to
be, all augmented by some handy extras
that elevate the experience further.

Mimestream has a 14-day free trial, and
it’s absolutely worth testing. It’s one of the
most considered, comprehensive email
clients we’ve tried. ALEX BLAKE

Email accounts can be
separated into tabs for quick
profile switching.

THE BOTTOM LINE

A brilliant Gmail
client that's easy
to use and stacked
with a plethora of
excellent ideas.

Familiar interface
B Full of clever touches

Extensively customizable

2 Gmail only
EXCELLENT mEEEI
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@ Reviews
Best of the best

Can't find the hardware or app you're looking for in our reviews section? Then check in
here — we've highlighted the best in every major category, as voted for by us

>HARDWARE

N [ (S [y vy
MESH ROUTER ASUS ZenWiFi XT9 $449.99  #201
4K USB-C MONITOR Ben( EW3280U $799.99  #169
THUNDERBOLT DOCK CalDigit Thunderbolt Station & [caldigit.com] $379.99  #199
KEYBOARD Cherry KW 9100 Slim for Mac $59.99  #208
PORTABLE PRINTER Epson WorkForce WF-TIOW $299.99  #185
PORTABLE HDD Toshiba Canvio Flex 2TB $79.99  #197
NAS DEVICE Asustor Flashstor 6 FS6706T NAS a4 #210
WIRELESS CHARGER Belkin BoostCharge Pro Portable $59.99  #197
DESKTOP SPEAKERS Creative Pebble Pro $59.99  #204
IN-EAR HEADPHONES Nothing Ear 2 L9 #209
SECURITY CAMERA EufyCam 2C (two-pack kit) $239.99 #171
SMART SPEAKER HomePod mini $99 #176
OVER-EAR HEADPHONES Sony WH-1000XM5 $399.99  #197
AIRPLAY SOUNDBAR Sonos Beam Su9 g
WEBCAM AnkerWork B60O Video Bar $219.99  #19]
PHOTO PRINTER Liene 4x6 photo printer $136.99  #190
PORTABLE BATTERY PACK Anker 533 $49.99  #198
MOBILE DOCK Kensington 8-in-1 USB-C Mobile Hub §TIS5  #190
OFFICE CHAIR Branch Verve 549 #201
MOUSE Logitech MX Master 3 $99.99  #198
ACTION CAMERA GoPro Hero 11 Black $500  #202
DESKTOP MICROPHONE Cherry UM 9.0 Pro RGB $13999  #209
PORTABLE DAC iFi Go Blu $199  #189
PORTABLE SSD Crucial X8 $219.99  #203
THUNDERBOLT &4 HUB Satechi Thunderbolt 4 Slim Hub $199.99  #205
CD/DVD DRIVE NOLYTH External DVD Drive $39.99  #204
TRAVEL CHARGER Mophie 3-in-1 travel charger $149.95  #202
iPHONE GAME CONTROLLER Razer Kishi v2 $99.99  #203
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>i0S/iPadOS APPS

T0 DO (PRODUCTIVITY)
WRITING

EMAIL

PHOTO EDITOR

VIDEO EDITOR
CAMERA

RSS READER
DESKTOP PUBLISHING
NOTE-TAKING
MIND-MAPPING
DOCUMENT SCANNER
CALENDAR

FITNESS

SHOPPING

GRAPHICS

PRODUCT

Things 3

& Scrivener

Spark

@ Pixelmator Photo 2
8 LumaFusion 3.0

. Obscura 3

PN Reeder 5

Affinity Publisher 2

€3 Notability 10

¥ MindNode 7

~= Genius Scan 6.0

£ Fantastical 3

W Gentler Streak
Grocery 3

Procreate for iPad

ulturedcode.co
iteratureandlatte.co

parkmailapp.co

uma-touch.co!

eeder.app
affinity.serif.co
pingerlabs.co

indnode.co

hegrizzlylabs.co

’ (= = 5 = = T
o 5
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@
o @
| E| B
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o o
T [ T
o
3 =
®

exibits.co

martgrocery.app

procreate.ar

$9.99 #194
$19.99 #138
Free #190
$4.99 #193

$29.99 (1APs) #186

$9.99 #196
$4.99 #176
$19.99 #206
$8.99 #174
$14.99 #184

Free (IAPs) #182
$4.99/month  #198
Free (IAPs) #199
Free #198

$9.99 #196

> macO0S APPS

T0 DO (PRODUCTIVITY)

WRITING
EMAIL
IMAGE EDITOR
VIDEO EDITOR
SCREEN CAPTURE
MUSIC CREATION
PASSWORD MANAGER
DESKTOP PUBLISHING
BACKUP
VIRTUALIZATION

E ‘ ANTIVIRUS
NOTE-TAKING

AUDIO AND VIDEO CONVERTER
VIRTUAL PRIVATE NETWORK

PRODUCT

Things 3

& Scrivener

Spark

& Pixelmator Pro 3
a Wondershare Filmora
% ScreenFlow 9

B Logic Pro

(s) Secrets

B Adobe InDesign
[# Carbon Copy Cloner
E] Paraliels Desktop 18

|

Intego Internet Security X9

/A Agenda

@ Wondershare UniConverter

@) NordveN

ulturedcode.co

iteratureandlatte.co

ksparkmailapp.co

pixelmator.co!

wondershare.co

elestream.n

pdobe.co

hombich.co

ondershare.co

ordvpn.co
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S = = @
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o 2 =
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$49.99 #194
$49 #200
Free #190
$49.99 #208
$109.99 #202
$129.00 #164
$199.99 #141

$19.99 #188

$20.99/month  #162
$39.99 #136
From $99.99 #201
$49.99/year #192
Free #204
$49.99/year #203

$11.95/month #186
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MEET YOUR NEW MAC

 for Apple love? We show

to swipe right on your
perfect Mac partner

ALSO INSIDE...

Turn your old Mac
Into a server

Give your old Mac a brilliant new job — by usingitas a
network-attached storage solution for your home

ISSUE 212
on sale

Get started
with Preview

The Mac's Preview tool is full of handy and helpful
features — here’s how to get the most out of it

10 OCT

..and much more!
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Mac|Lifes* RIS

Welcome back...
Welcome back MaciLife readers! I'm defghted 1o announce that cur sietier s
rebaming for 2023, slongside 8 new sel up for e Brand — moe on hy. Wl b
delvering the latest news, reviews and advice for owners and enthusasts of all Apole
davices, from Mac 1o IPhane, iPad and Apple Walch

Wi lack fanwmrd o provicing you with the best Mac content each manth, but if you'd
prater nol o receve newsletiers maving fanwands. plesse cick e to unsecribe

Thanks for baing & valusd MaciLife newsietier subscriber:

10 GAher P — SOMAIIng big has happened at MaciLife recenty.
= fanc 1 e el you af about . W' cesssed putl
wdition of the magazing, and o
anly be publahed in 8 digtal format,
|Phane or iPac (and Mac, more on that in a bit)
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Chacksfield, Andrew Cottle, David Crookes, Charlotte Henry, Hollin Jones, Cliff
Joseph, Carrie Marshall, Rob Mead-Green, Grace Morris, Howard Oakley, lan
Oshorne, Nick Peers, Alex Summersby

\What does this mean? If you've subscribed to the print version, youl be transfered over
1o this new: cigital formsat. DU subs teaim will contact you separstaly, to Bxplsn axacty

£ you nsed o do, 50 ook out for an emai Fom ws in the coming days. For thoss
business as usual, and nofing

gy sudiscribed bo the digita version, ifs
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THE ULTIMATE GUIDE TO THE
GREATEST ROGK MUSIG EVER MADE

Voted for by Classic Rock readers, these are the records that have soundtracked the lives
of generations, from The Beatles to Guns N' Roses and Metallica, via the Rolling Stones,
Led Zeppelin and Pink Floyd. It's the perfect guide to the albums you should own and love.
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